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Avant-propos 
 
 
Ce manuel a été créé par Hologic®, Inc. Il est destiné à guider l’utilisateur sur la façon de configurer, d’installer et d’utiliser le 
matériel Faxitron Path et le logiciel Vision, tous deux développés par Hologic®, Inc. 
 
Faxitron Path était auparavant connu sous le nom de PathVision. 
 
L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Veuillez consulter les procédures de configuration 
requises dans la Section 2 de ce manuel avant de continuer. 
 
 
 
Indications d’utilisation 
 
Le Faxitron Path est un système de radiographie monté dans une armoire, utilisé pour fournir des images sur film et/ou des 
images radiographiques numériques d’échantillons provenant de diverses régions anatomiques afin de vérifier rapidement que 
le tissu correct a été excisé durant la biopsie.  La possibilité de procéder à cette vérification directement dans la même pièce ou 
à proximité de celle où la procédure est effectuée accélère le déroulement des opérations et réduit ainsi la durée nécessaire à 
l’examen du patient.  La radiographie d’échantillons peut potentiellement limiter le nombre de rappels de patients. 
 
Utilisation sur ordonnance (Partie 21 CFR 801, sous-partie D). 
 

 Attention : les lois fédérales américaines limitent la vente de ce dispositif par un médecin ou sous prescription médicale. 
 
 
Le système peut fonctionner comme un dispositif autonome. Si le dispositif est connecté à un réseau, il est essentiel de mettre 
en œuvre des mesures visant à réduire le risque pour les patients en diminuant la probabilité que les fonctionnalités dudit 
dispositif soient intentionnellement ou non compromises par une cybersécurité inadéquate. 

 
www.hologic.com/package-inserts 

http://www.hologic.com/package-inserts
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Ce manuel a été créé par Hologic, Inc. Il est destiné à guider l’utilisateur avancé sur la façon 
de configurer, d’installer et d’utiliser le matériel Faxitron Path et le logiciel Vision, tous deux 
développés par Hologic, Inc. 
 
Lisez attentivement toutes les informations avant d’utiliser le système. Respectez tous les 
avertissements et toutes les précautions énoncés dans ce manuel. Conservez ce manuel à 
disposition pendant les procédures. Respectez toujours toutes les instructions de ce 
manuel. Hologic, Inc. décline toute responsabilité en cas de blessure ou de dommage 
résultant d’une utilisation incorrecte du système. Hologic peut vous proposer une formation 
dans votre établissement. 
 
Merci de la part de nous tous à Hologic, Inc. 
 
Fabricant et coordonnées 

 
 
 

Hologic, Inc. 
36 Apple Ridge Road 
Danbury, CT 06810, États-Unis 
1.800.447.1856 
www.hologic.com 
 

 
 

SPONSOR AU 
Hologic (Australie et Nouvelle-Zélande) Pty Ltd 
Suite 302, Level 3 
2 Lyon Park Road 
Macquarie Park NSW 2113 
Tél. : 02 9888 8000 
 

 
 
Hologic, BV 
Da Vincilaan 5 
1930 Zaventem 
Belgique 
Tél. : +32 2 711 46 80 
Fax : +32 2 725 20 87 
 

 

 

 1.0.0 
Introduction 

Les symboles suivants sont utilisés dans ce manuel et dans le système d’aide en ligne : 
 
 

Avertit le lecteur d’un risque d’électrocution s’il ignore l’avertissement et utilise 
délibérément des outils spécialisés pour ouvrir une armoire électrique scellée 
et manipuler son contenu.  Remarque : aucun outil n’est fourni par Hologic, 
Inc. 

Avertit le lecteur d’une situation dangereuse. Ce symbole est généralement 
accompagné d’un symbole plus spécifique et d’instructions appropriées 
concernant la nature du danger, l’issue prévisible du danger et les informations 
permettant d’éviter le danger. 

Incite le lecteur à faire preuve de prudence lorsqu’il soulève du matériel lourd 
afin d’éviter les blessures corporelles et les dommages matériels. 

Avertit le lecteur qu’un rayonnement ionisé est émis dans la zone marquée 
lorsque le faisceau de rayons X est activé. Le Faxitron Path est doté de 
dispositifs de verrouillage de sécurité pour empêcher l’accès à la zone marquée 
pendant que le faisceau de rayons X est activé. 

Avertit le lecteur qu’il doit utiliser une protection appropriée (comme des gants 
chirurgicaux ou un récipient pour échantillon approuvé) pour éviter l’exposition 
à des matières potentiellement infectieuses comme les échantillons de tissus 
des patients. 

 1.1.0 
Symboles 
d’avertissement 
et de mise en 
garde de ce 
manuel 

 

http://www.hologic.com/
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Symbole Description Norme 

 

Débarrassez-vous du 
matériel électronique et 
électrique séparément des 
déchets normaux. 
Renvoyez le matériel hors 
service à Hologic ou 
contactez votre 
représentant du service à la 
clientèle. 

Directive DEEE 
2012/19/UE 

 

Fabricant ISO 15223-1, 
référence 5.1.1 

 

Date de fabrication ISO 15223-1, 
référence 5.1.3 

 

Rayonnement ionisé émis 
lorsque le faisceau de 
rayons X est sous tension 

ISO 7010, 
référence W003 

 

Avertissement, utiliser une 
protection appropriée 

ISO 7010, 
référence W009 

 

Avertissement Électricité CEI 60417, 
référence 6042 

 

Avertissement ISO 7010, 
référence W001 

   

Consulter le mode  
d’emploi 

ISO 15223-1, 
référence 5.4.3 

 

Respecter le mode d’emploi CEI 60601-1, 
référence tableau 
n° D.2, signe de 
sécurité 10 
(ISO 7010-M002) 

 

Ce système transmet de 
l’énergie RF 
(radiofréquence) 
(rayonnements 
électromagnétiques non 
ionisants) 

CEI 60417, 
référence 5140 
 

 
 
 

1.1.1 
Symboles 
d’avertissement  
et de mise en 
garde sur les 
étquettes 
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Symbole Description Norme 

 

Représentant autorisé au 
sein de l’Union européenne 

ISO 15223-1, 
référence 5.1.2 

 
Dispositif médical ISO 15223-1, 

référence 5.7.7 
 
 

 

Numéro de catalogue ISO 15223-1, 
référence 5.1.6 

 

Numéro de série ISO 15223-1, 
référence 5.1.7 

 

Pays de fabrication ISO 15223-1, 
référence 5.1.11 

 

Traductions dans l’encadré Hologic 

 

Mise en garde ISO 15223-1, 
référence 5.4.4 

 

Limites d’humidité ISO 15223-1, 
référence 5.3.8 

 
 

Certification ETL 
 
 

Conseil canadien 
des normes (CCN) 
et Administration 
américaine de la 
sécurité et de la 
santé au travail 
(OSHA) 

 

Utilisation uniquement sur 
ordonnance 

FDA 21 CFR 
801.109 

 
Courant alternatif CEI 60417, 

référence 5032 

 

Marquage CE  
Conformité européenne 

Règlement RDM 
(UE) 2017/745 

 

Avertissement ; rayon laser ISO 7010, 
référence W004 
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Symbole Description Norme 

 

Bus universel en série 
(USB), port/prise 

ISO 7000-3650 

 

Mise en garde — 
Rayonnement 
(production de rayons X) 

Hologic 

 

Fusible CEI 60417, 
référence 5016 

 

Terre (masse) CEI 60417-5017 

 

Faire attention lorsque vous 
soulevez des objets lourds 

Hologic 

 

Remarque Hologic 
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SECTION 2 
Installation et  

configuration du  
Faxitron Path 

  

 
 
 
 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 001  

SECTION 
Installation et 
configuration 2 

2-2 

Faxitron® Path 
Système de radiographie d’échantillons 

Avertissements 
• Veuillez lire attentivement les instructions avant d’utiliser le système. 

• N’utilisez pas le système d’une manière autre que l’utilisation prévue, comme décrit dans 
ce manuel. En cas de doute, contactez Hologic ou votre distributeur agréé. 

• Tous les cordons d’alimentation ne sont pas prévus pour la même puissance. N’utilisez pas 
d’autre cordon d’alimentation avec ce système que celui fourni. N’utilisez pas le cordon 
d’alimentation de ce système sur un autre équipement. 

• Ce système a été testé conformément aux normes internationales les plus exigeantes ; 
toutefois, il est recommandé de contacter les autorités nationales en ce qui concerne les 
exigences opérationnelles locales. 

• Ce système n’est pas destiné à une utilisation publique. Il doit être situé dans une zone où 
le grand public ne peut pas accéder au système sans la présence d’un opérateur. 

Précautions générales 
Les précautions suivantes doivent être prises pour éviter d’endommager votre système Path : 

• Ne connectez ou déconnectez jamais les câbles de communication et/ou d’alimentation 
lorsque le système de caméra est sous tension. Des dommages au détecteur CMOS ou à 
l’électronique de la caméra peuvent survenir si les câbles sont connectés/déconnectés alors 
que l’appareil est sous tension. 

• Le système de la caméra est fragile et des précautions doivent être prises pour ne pas 
endommager la caméra. Le système de la caméra ne doit jamais être malmené, heurté, 
cogné ou laissé tomber. 

• Le système Path dispose d’un mode d’étalonnage. L’étalonnage doit être effectué 
quotidiennement pour assurer le bon fonctionnement du système. Veuillez vous reporter à 
la procédure d’étalonnage. 

• Mise en garde : l’utilisation de commandes ou de réglages pour effectuer des procédures 
autres que celles spécifiées dans le présent document peut entraîner une exposition à un 
rayonnement dangereux. 

Connexions interopérables 
Le Path peut fonctionner comme un dispositif autonome sans aucune entrée ou sortie vers 
d’autres dispositifs. Les images peuvent être capturées, stockées et examinées directement 
sur le système.  

Toutefois, le système est livré avec plusieurs interfaces. La principale est la connexion réseau 
qui permet au système d’être connecté à un système d’archivage et de transmission d’images 
(PACS, Picture Archiving and Communication System). Les images peuvent ensuite être 
transmises au format DICOM du dispositif directement au réseau de l’établissement via notre 
logiciel. Voir Section 6 pour plus de détails sur la version DICOM. Seuls des employés de 
Hologic ou le personnel informatique qualifié de l’établissement de l’utilisateur doivent 
configurer cette communication. 

Les connexions du système et leur utilisation prévue sont indiquées ci-dessous. Aucun autre 
type de dispositif ne doit être connecté au Path sans l’approbation de Hologic. 

 2.1.0 
Précautions et 
avertissements 
relatifs au 
système 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

Raccordement Usage Type de dispositif Utilisateur prévu 
Port Ethernet à 
l’arrière  

Pour stocker des images radiographiques 
sur un réseau de stockage de données. 

PACS ou stockage en 
réseau 

Configuré par le personnel de 
Hologic ou du service 
informatique de l’établissement. 
Utilisé par les cliniciens. 

Port Ethernet à 
l’arrière 

Pour permettre une connexion à distance de 
l’équipe d’entretien de Hologic, à des fins de 
diagnostic et de réparation du système. 

Connexion internet en 
réseau 

Personnel de Hologic ou du 
service informatique de 
l’établissement. 

Port USB à 
l’avant 

Pour transférer des images à partir du 
dispositif. Il ne doit être utilisé que si le 
PACS ou le réseau n’est pas disponible.  

Périphérique de 
stockage USB 
(clé USB) 

Cliniciens ou personnel du 
service informatique ayant un 
accès autorisé au système.  
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Raccordement Usage Type de dispositif Utilisateur prévu 
Port USB à 
l’avant 

Pour assurer la maintenance et l’entretien 
du système, il peut être nécessaire de 
copier les fichiers sur l’ordinateur et à partir 
de celui-ci. Par exemple, les mises à jour du 
logiciel ou les fichiers journaux.  

Périphérique de 
stockage USB 
(clé USB) 

Personnel de Hologic ou du 
service informatique de 
l’établissement. 

Port USB à 
l’arrière 

Pour permettre la connexion d’une 
imprimante. Le logiciel Vision permet de 
connecter une imprimante DICOM ou une 
imprimante standard compatible Windows.  

Imprimante DICOM 
ou Windows 

Cliniciens ou personnel du 
service informatique de 
l’établissement. 

 
Cybersécurité 
La sécurité des dispositifs est une responsabilité partagée entre Hologic et les 
établissements de santé. L’absence de maintien de la cybersécurité peut entraîner une 
compromission des fonctionnalités des dispositifs, une perte de disponibilité ou d’intégrité 
des données (médicales ou personnelles) ou l’exposition d’autres dispositifs ou réseaux 
connectés à des menaces de sécurité. Hologic effectue un ensemble de contrôles de 
cybersécurité pour garantir la cybersécurité de ses unités et pour assurer leur fonctionnalité 
et leur sécurité. 

Toutes nos unités utilisent le système d’exploitation standard Windows. Lors de l’installation, 
nous recommandons à l’établissement de mettre en place toutes les mesures de sécurité 
nécessaires définies par ses propres exigences internes, comme il le ferait pour tout autre 
PC connecté au réseau. 

L’établissement peut configurer le système d’exploitation Windows avec tous les protocoles 
de réseau et les autorisations nécessaires. Par exemple, ils peuvent ajouter : 

 • ID utilisateur et mots de passe. 
• Autorisation par couches avec authentification appropriée. 

 • Restrictions sur les installations de logiciels. 
 • Exigences relatives au contenu de confiance, y compris la vérification de la 

signature du code. 
 • Configurer les mises à jour de Windows, y compris les versions de sécurité. 

En outre, notre logiciel d’imagerie (Vision) peut être protégé par un mot de passe, de sorte 
que certains utilisateurs peuvent accéder au système d’exploitation sans pouvoir ouvrir le 
logiciel Vision. 

L’unité est livrée avec une clé physique qui permet d’activer le système de radiographie. 
Cela permet au système d’être verrouillé, de sorte que même si l’on accède au logiciel, 
aucune radiographie ne peut être lancée. 
 
Cette unité est conçue pour être utilisée soit comme une unité autonome, soit pour être 
connectée au PACS interne de l’établissement ou à un autre réseau en boucle fermée. Elle 
n’est pas destinée à être connectée à Internet, à moins que (a) l’établissement reçoive des 
instructions spécifiques de la part de Hologic, ou que (b) l’établissement prenne des 
précautions adéquates pour assurer sa cybersécurité face aux menaces liées à sa 
connexion à Internet.  

Hologic développera des mises à jour ou des correctifs pour le logiciel Vision afin de 
continuer à assurer la sécurité du produit, selon les besoins tout au long du cycle de vie de 
l’unité. 

Des mesures de sécurité supplémentaires, notamment le cryptage, peuvent être mises en 
œuvre et Hologic peut travailler avec le département informatique des établissements pour 
réduire le risque pour les patients à la suite d'une violation de la cybersécurité. 

 2.1.0 Suite 
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Nettoyage 
Chambre interne 
Les échantillons contenant des échantillons biologiques peuvent abriter des agents 
infectieux dangereux pour votre santé. Suivez les procédures de biosécurité appropriées : 
portez des gants lors de la manipulation des échantillons de tissus ou de tout matériau avec 
lequel ils sont entrés en contact. 

Essuyez régulièrement l’intérieur de l’armoire avec de l’alcool isopropylique à 70–90 % ou 
avec de l’hypochlorite de sodium dilué (5,25–6,15 % d’eau de Javel domestique diluée à 
1:500 fournit la concentration appropriée). Veillez à ce que la zone de l’échantillon, indiquée 
sur le sol de la chambre, soit nettoyée à fond. 

Chambre externe 
Essuyez régulièrement les surfaces externes avec de l’alcool isopropylique, de l’hypochlorite 
de sodium ou du savon doux et de l’eau. (Voir ci-dessus pour les concentrations 
appropriées.) Ne trempez pas ou n’inondez pas les surfaces et n’utilisez pas d’abrasifs qui 
pourraient rayer les surfaces. Ne laissez pas l’humidité entrer en contact avec les 
composants électriques du système. Testez les produits de nettoyage sur une petite zone 
non visible des capots en plastique et en métal pour vérifier qu’ils n’endommagent pas le 
revêtement. 

 
Inspection des caisses 
Le système Faxitron Path est livré dans une grande caisse en bois et dans une boîte. 
Demandez à l’agent de transport de déposer la caisse et la boîte dans une zone à l’abri du 
vol, des dommages ou des conditions environnementales extrêmes, jusqu’à ce que le 
représentant autorisé de Hologic puisse installer le système. 

Vérifiez si la caisse et la boîte sont endommagées. Si l’une des deux semble endommagée, 
contactez Hologic au 1-800-447-1856. 

La caisse fait environ quatre pieds (1,20 m) de haut. Cette caisse contient l’unité d’analyse 
des échantillons, l’ordinateur et les manuels du système. La boîte contient le moniteur du 
système. 

 
Levage et transport de la caisse 
Attention : la caisse pèse environ 550 livres (250 kg). Le système emballé doit être maintenu 
en position verticale, comme indiqué sur la caisse d’expédition.  

 
Déballage et assemblage du système 
Le système Faxitron Path doit être déballé et installé par un représentant autorisé de  
Hologic, Inc. 

 

Emplacement 
Le système Faxitron Path est doté d’une ventilation et le connecteur d’entrée d’alimentation 
se trouve à l’arrière de l’armoire. Laissez au moins 6 po (15 cm) d’espace libre derrière l’unité 
une fois installée pour permettre à l’air de circuler et pour permettre à l’utilisateur d’y accéder 
pour débrancher le cordon d’alimentation. 

 2.1.0 Suite 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
2.2.0 
Configuration du 
système 
Faxitron Path 
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Conditions environnementales 
En fonctionnement : 
Température :  15,5 à 30 degrés C ou 60 à 86 degrés F.  
Humidité relative :  < 75 %   
 
Stockage et transport : 
Température :  0 à 45 degrés C ou 32 à 113 degrés F.  
Humidité relative :  < 75 %   
 
 
Cet équipement a été conçu pour les conditions suivantes : 

• Utilisation intérieure. 
• Altitude jusqu’à 2 000 mètres. 
• Degré de pollution 2. 
• Surtension, catégorie II. 
 

Le Faxitron Path ne doit pas être déplacé une fois installé. Le système a été conçu comme 
un système fixe à installer sur un comptoir ou une table. 

 
RADIOPROTECTION 
• Armoire blindée contre les rayonnements. 
• Porte de compartiment équipée d’un double verrouillage de sécurité. 
• Rayonnement : moins de 0,1 mR/h à 5 cm (2 po) de la surface extérieure à kV maximum. 
• Certifié conforme aux normes établies par la US Food and Drug Administration, Center 

for Devices and Radiological Health, (21 CFR 1020.40). 
• Conçu pour être conforme aux normes établies par Underwriters Laboratory aux États-

Unis et au Canada. 
• Hologic recommande aux utilisateurs de suivre une formation en matière de protection 

de base contre les rayonnements ionisants avant d’utiliser le système. 
 
 
CONTRÔLE DE L’EXPOSITION :  Automatique ou manuel. 

CYCLE D’UTILISATION DES RAYONS X :  50 %. 

INFORMATION SUR LE LASER :  Produit laser de classe 1. 

CEI 60825-1 Éd. 2. 

Conforme aux normes 21 CFR 1040.10 et 
1040.11, sauf pour les déviations en vertu de 
l’Avis sur les produits laser numéro 50, daté 
du 24 juin 2007. 

CARACTÉRISTIQUES ÉLECTRIQUES :  100–250 V CA, 50/60 Hz, 200 VA max. 

PRODUCTION DE CHALEUR :  500 BTU/h max. 

 2.3.0 
Spécifications 
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DIMENSIONS EXTÉRIEURES (approximatives) 
 cm pouces 
Taille 90 36 
Largeur 59 23 
Profondeur 54 21 

 
 
DIMENSIONS INTERIEURES DU COMPARTIMENT (approximatives) 

 cm pouces 
Taille 57 22,3 
Largeur 39 15,5 
Profondeur 42 16,5 

 
 
POIDS (approximatif) 

 Avec ordinateur, moniteur, clavier et accessoires 
 kg lbs 
Net 210 465 
Expédition 258 570 
 Armoire uniquement 
Net 188 415 
Expédition 236 520 

 
 

 

 2.3.0 Suite 
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Étalonnage de la caméra 
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Étalonnage 

Lors de la mise en service initiale du système ou à n’importe quel moment souhaité par 
l’utilisateur, un étalonnage du système peut être effectué. Il est recommandé d’effectuer les 
étalonnages suivants lors de la mise en service initiale et toutes les douze (12) heures. 

Pour optimiser la qualité de l’image, le logiciel Vision et le matériel nécessitent un étalonnage 
périodique. Cet étalonnage nécessite l’acquisition d’images de référence. Ces images peuvent 
être regroupées en trois (3) catégories : images décalées, images sombres et images du 
champ plat. 

Le logiciel Vision s’ouvrira directement au menu d’accueil (Figure 3.1.1) ou à la page 
d’étalonnage (Figure 3.1.2) en fonction du temps écoulé depuis le dernier étalonnage. 
L’utilisateur peut naviguer jusqu’à la page d’étalonnage afin de lancer manuellement un 
étalonnage.  

 Attention : vérifiez que la chambre est vide avant de commencer l’étalonnage. 

Pour démarrer manuellement l’étalonnage, cliquez sur le bouton « Calibrate » (Étalonnage) 
dans le menu d’accueil. 

 
 
 
 
 
 
 
 
 
 
 
 
L’utilisateur sera alors invité à lancer l’étalonnage. 
 
 
 
 

 
 

 
 
 
 
 

Après avoir appuyé sur ce bouton, le processus d’étalonnage est effectué et la boîte de 
message d’étalonnage s’affiche. Pendant l’étalonnage, la boîte de message affichera 
« SYSTEM IN CALIBRATION » (Système en cours d’étalonnage) et « X-RAY ON » (Rayons X 
activés). Voir Figure 3.1.3.  
 
 
 
 
 
 
 
 
 
 
Le logiciel reviendra automatiquement au menu d’accueil à la fin de l’étalonnage. 
 
Reportez-vous aux sections 5.2.0 et 5.2.1 pour plus d’informations sur l’étalonnage. 

 3.1.0 
Étalonnage  
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 3.1.1  
Bouton Calibrate (Étalonnage)  
 
 
 
 
 
 
 
 
 
 
Figure 3.1.2 
Invite de démarrage 
d’étalonnage 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.1.3  
Étalonnage en cours 
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SECTION 4 
Démarrage rapide — 

Fonctionnement de base 
du Faxitron Path 
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Avant de mettre le système sous tension, veuillez vous assurer que tous les cordons et les 
câbles sont bien branchés sur le système, l’ordinateur et l’écran. 

Reportez-vous à la Section 2, Installation et configuration, du présent manuel, ainsi qu’aux 
guides d’installation et de démarrage rapide fournis avec votre système Path. 
 

 

 

 

 

 

 

 

 

 

 

 

 

Protocole applicable à la séquence de démarrage du système 

Cette séquence de démarrage doit être respectée pour assurer le bon fonctionnement du 
système et la qualité de l’image. 

Mise sous tension du système : 

• Placez l’interrupteur situé à l’arrière de l’armoire Path sur la position « MARCHE ». 
• Tournez la clé située à l’avant de l’armoire Path sur « MARCHE » (dans le sens des 

aiguilles d’une montre jusqu’à la position correspondant à trois heures). 
• Allumez l’ordinateur et l’écran. 

Démarrage du logiciel : 

• Vérifiez qu’il n’y a rien dans la chambre à rayons X du Path. 
• Le logiciel Vision doit démarrer automatiquement lorsque le 

système d’exploitation Windows a achevé son démarrage. Si le 
logiciel ne démarre pas automatiquement, faites un double clic sur 
l’icône Vision présente sur le bureau de Windows. 

Étalonnage : 

• Au premier démarrage de la journée, le logiciel devrait s’ouvrir sur la page 
d’étalonnage. 

• Appuyez sur le bouton « Calibrate » (Étalonnage) et patientez jusqu’à ce que le 
système termine l’étalonnage. 

Recommandations supplémentaires pour une qualité d’image cohérente. 

Laissez le système effectuer un étalonnage complet chaque jour avant la première utilisation 
du système. Le système est configuré pour effectuer cet étalonnage lorsque vous démarrez 
le logiciel Vision. 

Effectuez un étalonnage complet du système après avoir déplacé le système dans une autre 
pièce pour éviter les difficultés d’imagerie potentielles liées aux différences de température et 
d’humidité ambiantes d’une pièce à l’autre. 

 4.1.0 
Démarrage rapide 
 
 
 
Figure 4.1.1 
Panneau avant du Path 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.1.2 
Icône Vision sur le bureau 
 

Clé marche/arrêt 
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Procédures d’imagerie de base 

Avertissement : l’utilisation du Path d’une manière autre que celle décrite dans ce manuel 
peut entraîner un mauvais fonctionnement de l’équipement ou des blessures corporelles. 

Avertissement : utilisez des contenants ou des gants agréés afin d’éviter tout contact avec 
des échantillons de tissus de patients potentiellement dangereux. 

Démarrage de la procédure 

• Sur la page du menu d’accueil, sélectionnez le bouton Start Procedure (Démarrer 
la procédure). 

 

 

 

 

 

 

 

 

 

• L’utilisateur aura le choix entre Select from Work List (Sélectionner dans la liste de 
travail), Manual Entry (Saisie manuelle), Select from Database (Sélectionner dans 
la base de données), ou Continue with current patient (Continuer avec le patient 
actuel). 

• Pour saisir manuellement une nouvelle procédure, sélectionnez le bouton Manual 
Entry (Saisie manuelle). 

 

 

 

 

 

 

 

• La boîte de dialogue « Patient Information Editor » (Éditeur d’informations sur le 
patient) s’ouvre. 

 

 4.2.0 
Acquisition 
d’images 

 
 
 
Figure 4.1.3 
Menu d’accueil du programme 
Vision (écran principal) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.1.4 
Options de la procédure de 
démarrage 
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 Remarque : les champs obligatoires sont indiqués par un 
astérisque blanc (*). 
Les champs obligatoires par défaut sont : Patient Name (Nom 
du patient), Patient ID (ID du patient), Accession Number 
(Numéro d’ordre) et Laterality (Latéralité). 

• Saisissez tous les champs obligatoires. Le bouton Accept (Accepter) ne sera pas 
actif si l’un des champs obligatoires manque. L’utilisateur peut remplir d’autres 
champs s’il le souhaite. 

 Remarque : la date de naissance doit être saisie au format aaaa/mm/jj (par exemple, 
1962/08/13).  

• Sélectionnez Accept (Accepter) pour activer l’acquisition d’images. 

Imagerie à Rayons X 

• Placez l'(es) échantillon(s) dans un récipient pour échantillon fourni par Hologic, Inc. ou par 
votre établissement et déposez-le(s) à l’intérieur de la chambre à rayons X du Path. La 
zone d’imagerie est indiquée par un autocollant matérialisant son contour. (L’utilisateur peut 
également placer l’échantillon et le récipient sur le plateau d’agrandissement fourni avec le 
système Path.) 

• Appuyez sur le bouton vert Start X-ray (Démarrer les rayons X) (soit dans le logiciel soit 
en face avant de l’armoire à rayons-X) pour démarrer l’acquisition d’images/radiographies. 

 
 
 
 

 4.2.0 Suite 
 
Figure 4.1.5 
Écran des données du patient 
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• Attendez que l’image s’affiche. 

 Remarque : avec le mode Full Auto sélectionné, deux radiographies seront prises, la 
première pour déterminer les meilleurs réglages et la seconde pour l’image elle-même. Les 
réglages utilisés pendant l’exposition (kV et durée) sont affichés sur l’écran LCD de 
l’armoire. 

 Le logiciel Vision est configuré pour enregistrer automatiquement l’image dans la base de 
données Faxitron sur le disque local de l’ordinateur du système. L’utilisateur peut également 
enregistrer l’image sur le serveur des installations en cliquant sur l’icône PACS. Voir 
Figure 4.1.6. 

 
Pour plus d’informations sur le réglage des paramètres d’image, les commandes de rayons 
X et les options d’analyse et d’enregistrement, voir Section 5. 

 
 
4.2.0 Suite 

 
 
 
 
 
 
 
 
 
 

Figure 4.1.6 
Écran avec image 
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Le logiciel Vision est un ensemble complet d’acquisition et de traitement d’images, conçu 
exclusivement pour fonctionner avec les générateurs de rayons X de Faxitron (tels que les 
systèmes VersaVision, Faxitron Path, CoreVision et BioVision.) En plus des fonctions 
d’acquisition et de traitement, le logiciel offre un module de base de données étendue qui 
permet à l’utilisateur de commander et de gérer l’archivage, le stockage, le classement et la 
récupération des images. Le logiciel est également conforme à la norme DICOM (Digital 
Imaging and Communications in Medicine), ce qui permet d’enregistrer et d’imprimer les images 
des patients au format DICOM 3.0. Le logiciel a été préinstallé sur l’ordinateur qui était livré 
avec votre système à rayons X. 

L’étalonnage du système est requis au début de chaque nouvelle journée d’utilisation du 
système, pour garantir la meilleure qualité d’image. L’utilisateur du système peut également 
effectuer un étalonnage à tout moment pour garantir une qualité d’image optimale. 

Après l’étalonnage, le menu d’accueil s’affiche, ce qui permet de naviguer vers toutes les autres 
zones du logiciel. Pour faciliter l’utilisation, des boutons d’application sont disponibles, voir 
Figure 5.0.1. Ces boutons se trouvent au centre de l’écran. Les descriptions et définitions des 
boutons sont présentées dans les Sections suivantes de ce manuel.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Protocole de séquence 
La séquence de démarrage doit être respectée pour assurer le bon fonctionnement du système 
et la qualité de l’image. 

Mettez l’armoire Faxitron Path sous tension à l’aide de l’interrupteur situé à l’arrière de l’armoire. 
(L’interrupteur principal se trouve à côté de la prise du cordon d’alimentation.) Faites basculer 
sur « I » pour mettre en position « MARCHE » et sur « 0 » pour mettre en position « ARRÊT ». 

Mettez l’armoire Faxitron Path sur « MARCHE » en insérant la clé Faxitron Path dans 
l’interrupteur à clé situé sur le panneau avant et en la tournant dans le sens des aiguilles d’une 
montre jusqu’à la position « 3 heures ».  Remarque : la clé ne peut pas être retirée dans 
cette position. 

Allumez l’ordinateur et l’écran.  

Le logiciel Vision démarre automatiquement lorsque Windows a terminé sa 
séquence de démarrage. Une boîte de dialogue apparaît pour indiquer que 
le logiciel a été initialisé et qu’il est en cours de chargement. 

 REMARQUE : double-cliquez avec le bouton gauche de la souris sur 
l’icône Vision Software (logiciel Vision) (situé sur le bureau de Windows) si 
Vision ne démarre pas automatiquement. Voir Figure 5.1.1. 

Le logiciel Vision s’ouvrira au menu d’accueil ou à la page d’étalonnage en fonction du temps 
écoulé depuis le dernier étalonnage du système. 

Reportez-vous à la Section 3, « Étalonnage de la caméra », et à la Section 5.2.1, « Aperçu de 
l’étalonnage de la caméra » pour les protocoles d’étalonnage. 

 5.0.0 
Aperçu du logiciel 
Vision 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.0.1  
Menu d’accueil du logiciel Vision 
(écran de démarrage) 
 
 
 
 
 
 
 
 
 
 
 
 

5.1.0 
Démarrage du 
logiciel 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.1.1 
Icône du bureau du logiciel Vision 
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Introduction à l’étalonnage 
 
Pour optimiser la qualité de l’image, le logiciel Vision et le matériel nécessitent un étalonnage 
périodique. Cet étalonnage nécessite l’acquisition d’images de référence.  

Lors de la mise en service initiale du système ou à n’importe quel moment souhaité par 
l’utilisateur, un étalonnage du système peut être demandé et effectué. Il est recommandé 
d’effectuer les étalonnages suivants toutes les douze (12) heures. 

Ces images d’étalonnage de référence sont utilisées pour étalonner une image radiographique 
« brute » pixel par pixel, afin de générer une image « corrigée » pour l’affichage. Les corrections 
d’image effectuées comprennent les corrections de gain, de décalage et de linéarité. 

 

Séquence d’étalonnage 
 
Pour plus de commodité, le logiciel Vision combine les nombreuses étapes de l’étalonnage en 
une étape unique. 

Lorsqu’un système à rayons X Faxitron a été éteint pendant plus de douze (12) heures, le 
système demande automatiquement à être réétalonné. Il est fortement recommandé de 
réétalonner le système après une longue période d’inactivité ou après un déplacement du 
système d’une pièce à une autre, car les paramètres de température/humidité ambiante 
peuvent être différents.  

Pour étalonner le système à tout moment, cliquez sur le bouton 
Calibrate (Étalonner) dans le menu d’accueil de Vision (écran de 
démarrage), puis appuyez sur Start Calibration (Démarrer 
l’étalonnage). Voir les Figures 5.2.1 et 5.2.2. La boîte de dialogue 
affiche un message d’état pendant l’étalonnage. Voir Figure 5.2.3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pendant l’étalonnage, des rayons X peuvent être générés. Pendant la génération des rayons 
X, un bouton Stop X-Ray (Arrêter les rayons X) sera rendu visible pour permettre à l’utilisateur 
d’arrêter les rayons X par le biais du logiciel. 

 5.2.0 
Aperçu de 
l’étalonnage de la 
caméra 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.2.1  
Bouton Calibrate (Étalonner) du 
menu d’accueil  
 
 
 
 
 
 
Figure 5.2.2 
Bouton Start Calibrate (Démarrer 
l’étalonnage) 
 
 
 
 
 
 
 
 

Figure 5.2.3 
État de l’étalonnage 
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Il peut parfois être souhaitable d’incorporer les caractéristiques d’atténuation des rayons X d’un 
atténuateur uniforme dans les images d’étalonnage de référence en champ plat. Par exemple, 
si tous les objets qui doivent être balayés sont placés sur une mince plaque de plastique, les 
caractéristiques d’atténuation des rayons X de la plaque seront observées dans chaque image 
acquise. Dans ce cas, le fait de placer la plaque dans le faisceau de rayons X pendant 
l’acquisition de l’image d’étalonnage de référence en champ plat pourrait améliorer la qualité 
de l’image. Voici un résumé du protocole d’étalonnage avancé pour « Both » (Les deux) (champ 
plat et image) : 

Placez l’atténuateur uniforme sur le détecteur. Toute la surface du détecteur doit être recouverte 
par l’atténuateur. Pour obtenir des résultats optimaux, l’atténuateur doit être plus grand que la 
zone d’imagerie du détecteur. 

Depuis l’écran de démarrage du logiciel d’imagerie, appuyez sur l’icône ^ en haut à droite pour 
faire apparaître le menu. Sélectionnez l’élément du menu déroulant « Tools » (Outils) dans le 
menu horizontal situé en haut de l’écran, puis passez de « Advanced Tools » (Outils avancés) à 
« X-Ray Calibration/Exposure Setup » (Étalonnage des rayons X/Configuration de l’exposition). 

 REMARQUE : les valeurs de kV, de temps d’exposition et d’ADU/s 
peuvent varier par rapport à celles indiquées. 

• Sous « X-Ray Generator and Exposure Settings » (Générateur de rayons X et paramètres 
d’exposition), saisissez le réglage en kV du générateur dans le champ approprié. 

• Définissez une valeur pour « Magnification » (Agrandissement) ou laissez le réglage par 
défaut de un (1.0). 

• Sélectionnez le bouton « Set for » (Régler pour) « Both » (Les deux) dans la boîte de 
dialogue. 

• Laissez le réglage par défaut « user ADU target » (cible ADU utilisateur). L’exposition aux 
rayons X sera terminée lorsque le détecteur aura accumulé un niveau de signal moyen d’ADU 
acceptable pour votre générateur de rayons X. 

• Conservez le temps d’exposition par défaut du test et cliquez sur le bouton Acquire 
(Acquérir). Le système commencera automatiquement l’émission de rayons X et fera 
l’acquisition d’une image. 

• Lorsque l’exposition aux rayons X est achevée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

• Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]). Le système 
calcule cette durée et le nombre est grisé. 

 5.2.1 
Étalonnage avancé 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.2.4 
Boîte de dialogue Générateur de 
rayons X et exposition 
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• Saisissez la valeur du temps d’exposition calculé de « Time [s] » (Durée [s]) dans la zone de 
temps « Test Exposure » (Exposition test). Appuyez sur le bouton Acquire (Acquérir) pour 
lancer automatiquement les rayons X et obtenir une image. 

• Lorsque l’exposition aux rayons X est terminée, cliquez sur le bouton Estimate/Calculate 
(Estimer/Calculer). 

• Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]). 
• Saisissez à nouveau le temps d’exposition calculé dans le champ « Test Exposure » 

(Exposition test). 
• Cliquez sur le bouton Accept Settings (Accepter les paramètres).  
• Effectuez une procédure d’étalonnage standard, comme décrit dans la Section « Aperçu de 

l’étalonnage de la caméra ».  
Les utilisateurs expérimentés peuvent désirer régler les paramètres d’exposition « X-Ray Cal 
(Flat-Field) » (Étalonnage des rayons X [champ plat]) et « Manual Image » (Image manuelle) 
indépendamment ou « Both » (Les deux) (champ plat et image manuelle), comme décrit 
précédemment. En sélectionnant la case « Flat Field » (Champ plat), le système détermine le 
temps d’exposition optimal pour l’acquisition d’images en champ plat avec le niveau ADU 
souhaité. En conséquence, la sélection de « Manual Image » (Image manuelle) déterminera le 
temps d’exposition optimal pour le système avec un objet qui atténuera les rayons X. Pour de 
meilleurs résultats, toute la zone d’imagerie du détecteur doit être recouverte par l’objet. 

Après avoir sélectionné « X-Ray Cal (Flat-Field) » (Étalonnage des rayons X [champ plat]) et 
« Manual Image » (Image manuelle) et une fois le niveau ADU réglé, sélectionnez le bouton 
Acquire (Acquérir). Pour la sélection « Manual Image » (Image manuelle), il est souhaitable 
que l’objet ou l’atténuateur de rayons X soit dans le faisceau de rayons X. Appuyez sur le bouton 
Acquire (Acquérir) pour générer des rayons X et obtenir une image. Lorsque l’exposition aux 
rayons X est terminée, cliquez sur le bouton Estimate/Calculate (Estimer/Calculer). Le 
système calcule le temps optimal et le nombre est grisé. Cliquez sur le bouton Accept Setting 
(Accepter le paramètre) pour enregistrer les « Exposure Settings » (Paramètres d’exposition) 
dans le fichier de configuration du système.  Remarque : seuls les réglages ayant la case 
d’option sélectionnée sont enregistrés. Effectuez ensuite une procédure d’étalonnage 
standard, comme décrit dans la section « Aperçu de l’étalonnage de la caméra ». 

 5.2.1 Suite 

 
 
 
 
Le bouton Start Procedure (Démarrer la procédure) (voir Figure 5.0.1) amène l’utilisateur à la 
page Patient Data Entry (Saisie des données du patient), qui propose différents moyens de 
saisie des données du patient. Si aucune liste de travail n’a été configurée, l’option sera grisée 
et seules les options Continue with current patient (Continuer avec le patient actuel), Manual 
Entry (Saisie manuelle) et Select from Database (Sélectionner dans la base de données) 
seront accessibles. Les options sont détaillées dans les sections suivantes. 
 

 

 5.3.0 
Données du patient 
 
 
 

Figure 5.3.1 
Écran de saisie des données du 
patient 
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SÉLECTIONNER DANS LA LISTE DE TRAVAIL  
(liste de travail distante de la modalité) 

Si une liste de travail a été configurée, l’utilisateur peut cliquer sur le bouton Select from Work 
List (Sélectionner dans la liste de travail) qui affichera la page suivante. Voir Figure 5.3.2 
ci-dessous. 

 

Les différents filtres sur la gauche peuvent être utilisés pour rechercher des procédures 
programmées pour l’entité d’application (AE) de la station de travail. Vérifiez que le titre de l’AE 
de la station de travail est défini, puis tout champ unique ou toute combinaison de champs peut 
être utilisé(e) comme filtre pour rechercher des procédures programmées pour cette AE. En 
sélectionnant le bouton Query (Interroger) situé dans le coin inférieur gauche, le tableau est 
rempli à nouveau avec les entrées correspondant aux informations recherchées. 

L’utilisateur peut alors cliquer sur n’importe quelle entrée puis sur Submit (Soumettre) pour 
remplir automatiquement l’éditeur d’informations sur l’imagerie avec les informations du patient. 

REMARQUE : l’utilisateur peut également double-cliquer sur n’importe quelle entrée du tableau 
pour accéder rapidement à l’éditeur d’informations sur l’imagerie sans avoir à appuyer sur 
Submit (Soumettre). 

L’éditeur d’informations sur l’imagerie (boîte de dialogue d’informations sur le patient) s’ouvrira. 
Voir Figure 5.3.3. Remplissez les autres champs obligatoires et cliquez sur Accept (Accepter) 
pour procéder à l’acquisition des images.  

 

 5.3.1 
Sélectionner dans 
la liste de travail 
 
 
 
 
Figure 5.3.2 
Boîte de dialogue Rechercher la 
liste de travail de la modalité 

 

 REMARQUE : toutes les données du patient sont 
fictives. Toute ressemblance avec des personnes 
réelles est strictement fortuite. 
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 Remarque : les champs obligatoires sont indiqués par un astérisque blanc (*). Les champs 
obligatoires par défaut sont : Patient Name (Nom du patient), Patient ID (ID du patient), 
Accession Number (Numéro d’ordre) et Laterality (Latéralité). 
 
L’utilisateur doit compléter tous les champs 
requis avant de pouvoir sélectionner le bouton 
Accept (Accepter). L’utilisateur peut 
également saisir la date, le médecin traitant, le 
nom de la procédure, le sexe, le technicien, la 
vue de la position, la partie du corps et l’ID de 
l’étude si nécessaire. Le nom de la procédure, 
la vue de la position et la partie du corps sont 
choisis via un menu déroulant. 
 

 Remarque :  la date doit être inscrite dans 
le format aaaa/mm/jj (par 
exemple, 1962/08/13). La 
non-saisie d’une date valide 
peut entraîner des erreurs lors 
de la récupération des 
images. 

 
 Remarque :  les « champs obligatoires » 

peuvent être modifiés ou 
supprimés selon l’application. 
Contactez l’assistance 
Hologic pour plus 
d’informations. 

 
Sélectionnez Accept (Accepter) pour continuer 
ou Start a New Patient or Procedure 
(Démarrer un nouveau patient ou une nouvelle 
procédure) pour revenir à la page de saisie des 
données du patient. 

 5.3.1 Suite 
 
 
 
Figure 5.3.3 
Éditeur d’informations sur 
l’imagerie 

 
 
 

Continuer avec le patient actuel 
 
 
Cliquez sur ce bouton pour continuer la procédure du patient actuel. L’« Éditeur d’informations 
sur l’image » s’ouvrira. Voir Figure 5.3.3. Suivez la procédure et les remarques ci-dessus. 
 

 5.3.2 
Continuer avec le 
patient actuel 

 
 
 

Saisie manuelle 
 
 
Cliquez sur ce bouton pour saisir manuellement une nouvelle procédure. L’éditeur 
d’informations sur l’imagerie s’ouvrira. Voir Figure 5.3.3. Suivez la procédure et les remarques 
ci-dessus. 
 

 5.3.3 
Saisie manuelle 
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Sélectionner dans la base de données 
 
En choisissant le bouton Select from Database (Sélectionner dans la base de données), la 
page suivante s’affiche. Voir Figure 5.3.4 ci-dessous. 

 
 
L’utilisateur sélectionne un patient dans le tableau situé sur le côté droit de la page et clique 
ensuite sur le bouton Accept (Accepter) qui ouvre l’éditeur d’informations sur l’image.  
(  Remarque : l’utilisateur peut également double-cliquer sur l’entrée dans le tableau pour 
ouvrir l’éditeur d’informations sur l’image) Suivez ensuite la procédure et les remarques de la 
page 5-7. 
 

 Remarque : utilisez la barre de défilement en bas de l’écran pour afficher les informations 
cachées sur le patient. 
 
Vision permet à l’utilisateur de réduire la liste des patients en saisissant des informations 
spécifiques dans la fenêtre « Search Parameters » (Paramètres de recherche) sur le côté 
gauche de la page. Seuls les patients correspondant à tous les paramètres de recherche 
s’afficheront.  
 

 5.3.4 
Sélectionner dans 
la base de données 
 
Figure 5.3.4 
Sélection du patient à partir des 
entrées de la base de données 
locale 
 
 

 REMARQUE : toutes les données du patient 
sont fictives. Toute ressemblance avec des 
personnes réelles est strictement fortuite. 
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Si l’utilisateur souhaite modifier ou consulter les informations après leur saisie, 
mais avant qu’une image ne soit prise, il peut cliquer sur l’icône Patient Data 
(Données du patient) dans le coin supérieur gauche. Voir Figure 5.3.5. 

 

 

La fenêtre d’édition des informations sur le patient/l’imagerie s’ouvre. Cette fenêtre d’édition 
sera complétée avec toutes les informations précédemment saisies/sélectionnées. Voir 
Figure 5.3.6.  Remarque : la fenêtre d’édition comprendra désormais un bouton Cancel 
(Annuler). 

L’utilisateur peut modifier ou ajouter des 
informations à sa guise, puis cliquer sur : 

• Le bouton Accept (Accepter) pour 
enregistrer les modifications et continuer 
l’acquisition d’images. 

• Le bouton Cancel (Annuler) pour annuler les 
modifications et continuer l’acquisition 
d’images. Le logiciel reviendra aux 
informations initiales saisies sur le patient, ou 

• Le bouton Start a New Patient or 
Procedure (Démarrer un nouveau patient ou 
une nouvelle procédure) qui renvoie 
l’utilisateur à l’écran de saisie des données 
du patient. Voir Figure 5.3.1. 

  

 

 
 
 

 

 

 

 

 

 

 

 

 

 

Une fois que l’utilisateur a cliqué sur le bouton Accept (Accepter), le système est prêt pour 
l’acquisition d’images/de radiographies. 

Les rayons X sont générés en appuyant sur le bouton vert Start (Démarrer) situé à l’avant de 
l’armoire Faxitron Path ou en cliquant sur le bouton Start X-Ray (Démarrer les rayons X) dans 
le coin inférieur droit de l’écran. Voir la Section 4.2.0, Acquisition d’images. Le système prendra 
une courte radiographie « échantillon », ou pré-photo (explications à la Section 5.4.4) suivie 
d’une exposition plus longue pour acquérir l’image. Le logiciel traitera l’image avant qu’elle ne 
soit affichée sur l’écran du moniteur. Une fois l’image affichée, les boutons situés à gauche et 
à droite de l’écran, couverts tout au long de cette section, seront activés. 

 5.3.5 
Icône de données 
du patient 
 
Figure 5.3.5 
Icône de données du patient 
 
 
 
 

Figure 5.3.6 
Boîte de dialogue Image 
Properties (Propriétés de l’image) 
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L’utilisateur peut consulter, mais non modifier, les 
informations sur le patient après avoir acquis une 
image en cliquant sur l’icône Patient Data (Données 
du patient) de la Figure 5.3.5. Une boîte de dialogue 
modifiée d’informations sur le patient apparaîtra 
alors, comme le montre la Figure 5.3.7. Cette boîte 
comporte deux boutons : Close Dialog (Fermer la 
boîte de dialogue) ou Start a New Patient or 
Procedure (Démarrer un nouveau patient ou une 
nouvelle procédure).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Une fois qu’une image est prise, les propriétés de l’image actuelle peuvent être 
visualisées en appuyant sur l’icône (i) dans le coin supérieur droit. Voir Figure 5.3.8. 
La boîte de dialogue des propriétés de l’image s’affiche dans le coin supérieur droit 
de l’image. La boîte de dialogue est semi-transparente, pour permettre de voir ce 
qui se trouve en dessous. Voir figure 5.3.9. 
 

 5.3.5 Suite 
 
Figure 5.3.7 
Boîte de dialogue Patient 
Information (Informations sur le 
patient) après l’acquisition 
d’images 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.3.8 
Icône de propriétés de l’image 
 
 
 
 
Figure 5.3.9 
Boîte de dialogue Image 
Properties (Propriétés de l’image) 
(visualisation uniquement) 
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Le logiciel Vision fournit divers outils et menus pour contrôler divers attributs ou paramètres 
d’image, l’acquisition de rayons X, les vues d’image, les outils d’image et les paramètres/accès 
DICOM. Les outils les plus couramment utilisés se trouvent dans une barre d’outils. La barre 
d’outils et les menus sont décrits plus en détail dans les pages suivantes. 

 
Le logiciel Vision permet d’accéder d’un seul clic à un certain nombre d’outils ou de fonctions 
couramment utilisés grâce à une barre d’outils verticale située sur le côté gauche de l’écran. 
Des descriptions plus détaillées suivent dans les pages suivantes. Voir Figure 5.4.1. 

 
 
Afficher/modifier les informations  
sur le patient 
(Voir Section 6.3.5 et Figure 6.3.5) 
 
 
Icône Améliorer l’image 
 
 
 
Outil de niveau de la fenêtre et  
de contraste 
 
 
Outil de zoom numérique 
 
 
 
Outils d’annotation 
 
 
 

Enregistrement PACS 
 
 
 

Impression PACS 

 

Contrôle de l’exposition  
(panneau de commande du dispositif) 

 
 
Retour au menu principal 

 

 
Arrêt du système 

 

 5.4.0 
Barre d’outils et 
menus 
 
 
5.4.1 
Barre d’outils 
latérale 
 
 
Figure 5.4.1 
Barre d’outils latérale 

 

 REMARQUES : 
 
Les outils suivants sont toujours 
actifs dans la page d’acquisition 
d’images : 
• Afficher/modifier les informations 

sur le patient. 
• Contrôle de l’exposition. 
• Retour au menu principal, et  
• Arrêt du système. 
 
Les outils suivants seront désactivés 
après la saisie des données du 
patient et ne seront activés qu’après 
l’acquisition d’une image 
radiographique : 
• Améliorer l’image. 
• Niveau de la fenêtre et contraste. 
• Zoom numérique, et 
• Annotation. 
 
Les outils d’enregistrement PACS et 
d’impression PACS ne sont activés 
qu’après l’acquisition d’une image 
radiographique et lorsque le système 
est connecté à un réseau PACS. 
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Améliorer l’image 
Le bouton présenté à la Figure 5.4.2 traite l’image sur l’écran pour mettre en valeur les détails 
plus petits, tels que les micro-calcifications et les petites masses dans l’image. 

 

 

L’algorithme, communément appelé « Peripheral Equalization » (Égalisation périphérique) ou 
« Thickness Equalization » (Égalisation d’épaisseur) en imagerie avancée, est appliqué à 
l’ensemble de l’image. En plus de cet algorithme, Hologic utilise un deuxième algorithme 
développé en interne appelé « Calcification Emphasis » (Accentuation de la calcification). Cet 
algorithme secondaire a été conçu pour faire ressortir les petits détails de l’image et les rendre 
beaucoup plus faciles à voir et à analyser. 

Comme les images des patients constituent une catégorie plus générale pour les géométries 
et les différentes épaisseurs possibles, certains échantillons peuvent avoir des géométries 
délicates et l’utilisateur doit utiliser cet outil avec précaution. 

Le système sera inactif (en veille) pendant le traitement. Une fois terminé, le bouton restera 
enfoncé/actif. L’utilisateur peut annuler le processus en appuyant à nouveau sur le bouton.  

 5.4.1 Suite 
 
Figure 5.4.2 
Icône d’amélioration de l’image 
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Réglage de l’inversion, du niveau de la fenêtre et du contraste 
 
Le bouton, illustré à la Figure 5.4.3, ouvre l’outil de réglage du niveau de la fenêtre et du 
contraste. Cet outil permet à l’utilisateur d’ajuster le niveau de la fenêtre et le contraste de 
l’image. L’utilisateur peut également restaurer le contraste d’origine en appuyant sur le bouton 
Original Contrast (Contraste d’origine), ou inverser l’image, en appuyant sur le bouton Invert 
(Inverser). L’inversion fait passer le schéma de couleurs d’une prédominance de noir à une 
prédominance de blanc et inversement. Voir Figure 5.4.4 ci-dessous. 
 
 
 
 
 
 
 
 
 
 
 
L’utilisateur peut également régler le curseur pour le 
contraste d’image désiré en cliquant sur le curseur 
et en le déplaçant vers le haut et vers le bas ou en 
cliquant sur l’une des flèches indiquées sur le 
curseur pour déplacer les limites inférieures ou 
supérieures du niveau de la fenêtre. Voir 
Figure 5.4.3 (officieusement, ceci est également 
connu sous le nom de « Window Leveling » (Mise à 
niveau de la fenêtre)). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Un exemple d’inversion est présenté ci-dessous :  

 

 5.4.1 Suite 
 
 
 
 
 
 
 
Figure 5.4.3 
Icône et commandes de l’outil de 
niveau de la fenêtre et de 
contraste 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.4 
Exemple d’inversion avec 
l’outil de réglage du contraste et 
niveau de la fenêtre 
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Réglage dynamique du zoom 
 
L’icône de l’outil de zoom, Figure 5.4.5, ouvrira l’outil de réglage du zoom. Après avoir ouvert 
cet outil, l’utilisateur peut utiliser la barre de défilement pour ajuster le niveau de zoom ou cliquer 
sur les boutons Fit to Specimen (Ajuster à l’échantillon), Fit to screen (Ajuster à l’écran) ou 
Zoom 1.0x (Zoom x1,0) (pleine résolution). Voir Figure 5.4.6. Lorsqu’un zoom a été effectué 
sur l’image, un panoramique est nécessaire pour naviguer dans l’image. Une boîte de dialogue 
sous forme de vignettes apparaîtra dans le coin supérieur gauche de l’écran, voir la Figure 5.4.7 
ci-dessous. Cliquez sur le bouton gauche sur l’image et maintenez-le enfoncé, puis déplacez 
la souris pour déplacer l’image dans l’écran principal. 

Notez que traditionnellement, cette fonction est aussi appelée « Pan View » (Panoramique) 
et/ou « Pan and Scan » (Panoramique et balayage). 

 
 
 
 
 

 
 
 
 
 
 
 
 
Le bouton Fit to Specimen (Ajuster à l’échantillon) tente de 
détecter et de zoomer sur l’échantillon afin de s’assurer qu’il est 
entièrement visible. Si aucun échantillon n’est détecté, il 
reviendra par défaut au mode précédent (soit « Fit to Screen » 
(Ajuster à l’écran) ou « Zoom 1.0x » (Zoom x1,0)). 
 
L’option Fit to screen (Ajuster à l’écran) ajuste l’image à l’écran. 
 
Le Zoom 1.0x (Zoom x1,0) est traditionnellement appelé « Full 
Resolution » (Pleine résolution) car il offre une vue de l’image à 
la taille 1-1 avec la résolution du moniteur. 
 
 
 
 

 5.4.1 Suite 
 
 
 
 
 
 
 
 
 
Figure 5.4.5 
Icône d’outil de zoom 
 
 
 
Figure 5.4.6 
Outil de réglage du niveau de 
zoom 
 
 
 
Figure 5.4.7 
Exemple de vue panoramique 
(à gauche) 
 

 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 001  

SECTION 
Logiciel Vision 5 

5-15 

Faxitron® Path 
Système de radiographie d’échantillons 

Annotation 

Le bouton présenté sur la Figure 5.4.8 ouvre les outils d’annotation. Ces outils et leurs 
nombreuses options sont présentés plus en détail à la section 5.8.0. 

 

 

Enregistrement PACS 
Le bouton présenté à la Figure 5.4.9 fonctionne uniquement lorsque le système est 
installé dans un établissement médical doté d’un réseau PACS. Pour enregistrer 
vos fichiers localement, reportez-vous à la Section 5.7.0. 

 

Impression PACS 
Le bouton présenté à la Figure 5.4.10 fonctionne uniquement lorsque le système est 
installé dans un établissement médical doté d’un réseau PACS. Pour une 
impression locale, reportez-vous à la Section 5.7.0. 

 

Panneau de commande du dispositif 
Le bouton présenté à la Figure 5.4.11 ouvre le panneau de commande du dispositif, 
qui permet à l’utilisateur du dispositif de commander facilement le système de 
radiographie par le biais du logiciel. L’utilisateur peut facilement sélectionner le 
mode d’exposition, le réglage des kV du tube à rayons X, le temps d’exposition et 
le nombre d’images à acquérir pour le calcul de la moyenne des images (si désiré) 
ainsi que lancer l’exposition aux rayons X.  

 REMARQUE : l’état ou la disponibilité des 
paramètres d’exposition est indiqué par les flèches 
haut/bas adjacentes au paramètre. Les flèches 
seront blanches pour les paramètres actifs et bleu 
clair pour les paramètres inactifs. Les paramètres 
d’exposition qui sont actifs dépendent du mode 
d’exposition sélectionné. 

La Figure 5.4.12 à droite montre que le mode 
entièrement automatique a été sélectionné et que 
les moyennes kV, temps et image sont toutes 
actives. L’utilisateur peut ajuster chacun de ces 
paramètres. 

 

 

Notez que le paramètre mA dans le système 
Faxitron Path n’est pas réglable par le logiciel. Les 
paramètres mA seront affichés comme inactifs. 

 

Lorsque vous avez terminé, cliquez sur le bouton 
Request X-Rays (Demande de rayons X) pour 
acquérir une image, ou sur le bouton Set (Régler) 
pour enregistrer les paramètres et fermer le 
panneau de commande du dispositif. 

 

Si vous cliquez sur le bouton Cancel (Annuler), le panneau de commande du dispositif se 
fermera sans enregistrer les modifications. 

 5.4.1 Suite 
 

Figure 5.4.8 
Icône d’annotations  
 
 
Figure 5.4.9  
Icône d’enregistrement 
PACS  
 
 
 

Figure 5.4.10  
Icône d’impression PACS  
 
 
  
 
 

Figure 5.4.11  
Icône de retour à la procédure 
 
 
 

Figure 5.4.12 
Panneau de commande du 
dispositif 
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Retour à la procédure 

Le bouton présenté à la Figure 5.4.13 permet de quitter le mode d’acquisition d’image 
et de revenir à l’écran du Menu Principal.  

 

Arrêt 
Le bouton, illustré à la Figure 5.4.14, permet de quitter le logiciel et d’éteindre le 
système. 
 
 
 

Remarques supplémentaires concernant les boîtes de dialogue 
 
Lorsqu’une boîte de dialogue est ouverte, elle est « ancrée » à gauche de l’écran. Si un 
utilisateur souhaite désolidariser la boîte de dialogue, il peut cliquer sur l’icône « Épingle » en 
haut à droite pour désolidariser la boîte de dialogue et pouvoir la faire glisser librement. 
L’épingle se transforme alors en icône « X » permettant une fermeture rapide. 
 
L’utilisateur peut également naviguer rapidement entre les différentes boîtes de dialogue en 
cliquant sur le menu de gauche. Ce faisant, le menu de gauche se ferme rapidement et ouvre 
les boîtes de dialogue appropriées. 

 

Barre de menu supérieure 
Le logiciel permet d’accéder aux menus « View » (Affichage), « Tools » (Outils), « Image 
Tools » (Outils image), « DICOM Utilities » (Utilitaires DICOM) et « Help » (Aide) via une barre 
de menu supérieure. Voir Figure 5.4.15. La barre de menu supérieure est masquée par défaut 
et s’affiche en cliquant sur le bouton Flèche dans le coin supérieur droit de l’écran. Voir 
Figure 5.4.16. Le bouton Flèche est noir ou blanc selon la page du logiciel ou le fond d’écran. 
Chaque élément du menu est traité en détail dans les pages suivantes. 

 

 

 Remarque : la flèche pointe vers le bas lorsque le menu supérieur 
est masqué et pointe vers le haut lorsqu’il est affiché. 

 

 

Menu View (Affichage) 
Le menu « View » (Affichage) est situé dans le menu principal supérieur et contient les éléments 
de sous-menu indiqués dans la Figure 5.4.17 ci-dessous. Chaque élément de sous-menu sera 
décrit plus en détail dans les pages suivantes. 

 

 

 

 5.4.1 Suite 
 
Figure 5.4.13 
Icône de retour au menu d’accueil 
 
 

Figure 5.4.14 
Icône d’arrêt du système 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.4.2  
Barre de menu 
supérieure 
 
 

 

Figure 5.4.15 
Barre de menu supérieure 

 
Figure 5.4.16 
Boutons de la barre de menu 
supérieure 
 
 
 
5.4.3 
Menu Affichage 
 
 
 
Figure 5.4.17 
Menu View (Affichage) 
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Zoom Mode (Mode Zoom) 
 

Normal (Normal) 
Affiche l’image acquise dans son format d’origine. L’image dans les systèmes Faxitron Path 
dépasse la zone d’affichage des moniteurs. Une boîte de dialogue de vignettes s’affiche dans 
le coin supérieur gauche de l’image et permet à l’utilisateur de « faire un panoramique » de 
l’image. Reportez-vous au réglage dynamique du zoom à la Section 5.4.1.  

 

Adjust Zoom (Régler le zoom) 
Cette option est grisée et n’est pas disponible pour le moment. 

 

Fit to Sample (Ajuster à l’échantillon) 
Cette option permet d’ajuster l’image acquise pour qu’elle corresponde au mieux à l’échantillon 
dans la zone d’affichage du moniteur. 

 

Fit All (Ajuster tout) 
Cette option affiche l’ensemble de l’image acquise, quel que soit son format d’origine. L’option 
Full Resolution (Pleine résolution) ne fonctionne pas dans ce mode d’affichage. 

 

Fit Width (Ajuster la largeur) 
Cette option permet d’afficher l’image acquise sur toute la largeur disponible de la zone 
d’affichage. 

 

Fit Height (Ajuster la hauteur) 
Cette option permet d’afficher l’image acquise sur toute la hauteur disponible de la zone 
d’affichage. 

 

Image Averages (Moyennes des images) 
Cette option permet à l’utilisateur de régler le nombre de moyennes d’images à prendre par 
exposition. Les options disponibles sont les suivantes : prises de vue x1, x2, x4 ou x8. Le 
réglage par défaut est le suivant : prises de vue x1. Si l’utilisateur sélectionne 2, 4 ou 8 prises 
de vue, le logiciel acquiert le nombre d’images sélectionnées dos à dos par une simple pression 
sur le bouton Start (Démarrer) et fait la moyenne de ces images en une seule. 

 

Image Perspective (Perspective d’image) 
Cette option permet à l’utilisateur de faire pivoter l’image affichée de 0, 90, 180 et 270 degrés 
pour l’orienter. 

 5.4.3 Suite 
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Grid Options (Options de grille) 
Lorsqu’une image est affichée, que ce soit une image acquise ou une image récupérée dans la 
base de données, l’utilisateur peut activer une grille. Elle permet également à l’utilisateur de 
régler l’espacement de la grille (pas). Voir l’exemple ci-dessous. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

User Window Levels (Niveaux de la fenêtre utilisateur) 
Ceci permet à l’utilisateur de définir jusqu’à trois (3) niveaux de fenêtre (WL) prédéfinis et définis 
par l’utilisateur. Sélectionnez d’abord le bouton Window Level (Niveau de fenêtre). Réglez le 
niveau de fenêtre (WL) sur le niveau souhaité. Dans les outils « View » (Affichage), sélectionnez 
« User Window Levels » (Niveaux de fenêtre utilisateur). Sélectionnez « Record Current WL as 
USER WL #1, #2 or #3 » (Enregistrer le WL actuel en tant que WL UTILISATEUR N°1, N°2 ou 
N°3). Le WL réglé sera enregistré sous le choix précédemment sélectionné. 

Default Window Level (Niveau de fenêtre par défaut) 
L’utilisateur a le choix entre deux niveaux « Default Window Levels [WL] » (Niveaux de fenêtre 
[WL] par défaut). « Optimize for whole area » (Optimiser la zone entière), qui ajuste le WL pour 
l’image entière, ou « Optimize for sample » (Optimiser pour l’échantillon), qui ajuste le WL pour 
la zone sous l’échantillon uniquement. De plus, il existe une option permettant de définir le 
« Default Window Level » (Niveau de fenêtre par défaut) qui est utilisé pour toutes les images 
obtenues, situées ici aussi. Ceci définira le niveau de fenêtre par défaut basé sur les statistiques 
de l’image ; cette action devra être effectuée séparément pour les images non améliorées et 
améliorées. 

Default Aspect of Raw Files  
(Aspect par défaut des fichiers bruts) 

Cet outil est disponible sous le menu VIEW (AFFICHAGE). Il permet d’importer/ouvrir des 
fichiers d’images précédemment enregistrés avec des attributs de fichiers inconnus ou des 
données d’images binaires sans aucune information d’en-tête. Comme la taille exacte du 
tableau de l’imageur n’est pas disponible dans l’en-tête du fichier de données d’image, on 
utilisera les dimensions de l’imageur les plus proches pour importer/ouvrir ces images, en se 
basant sur le fait que la largeur est supérieure ou inférieure à la hauteur (informations d’aspect 
par défaut). 

 5.4.3 Suite 
 
 
 

Figure 5.4.18 
Affichage de la grille 
d’échantillonnage 
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Enhance Image (Améliorer l’image),  
identique au bouton du même nom 

Traite l’image actuelle du patient et améliore la visualisation des tissus situés près de la 
périphérie de l’échantillon. 

Sample Viewer (Affichage d’échantillon) 
Si le système est équipé d’une caméra Web, celle-ci active la visionneuse de caméra Web du 
système pour permettre l’orientation et l’alignement de l’échantillon. 

Review Layout (Mise en page de la révision) 
Aide l’utilisateur à configurer plusieurs volets d’image en mode Review (Révision) (base de 
données) du programme. Les options disponibles sont les suivantes ; mise en page « (1 X 1) 
Single » (Simple [1 X 1]), « (2 X 1) Double H » (Double H [2 X 1]), « (1 X 2) Double V » (Double 
V [1 X 2]), « (1 + (2 X 1) Triple » (Triple [1 + (2 X 1)]) et « (2 X 2) Quadruple » (Quadruple 
[2 X 2]). Pendant les opérations sur plusieurs volets, l’utilisateur peut cliquer une fois sur le 
volet/image désiré(e) pour en faire la sélection courante ; la bordure rectangulaire du volet 
sélectionné deviendra verte. Les images dans la vue Liste de base de données ou dans la vue 
Vignettes de la base de données seront ouvertes dans le panneau sélectionné à l’aide d’un 
double-clic. L’utilisateur peut également ouvrir les images dans les volets souhaités directement 
à partir du menu contextuel (clic droit) des vues de la base de données mentionnées. Après 
avoir activé le menu contextuel à l’aide d’un clic droit, l’utilisateur peut choisir parmi les volets 
listés sous OPEN TO→ (OUVRIR DANS) qui lui fourniront les volets disponibles pour ouvrir 
l’image (gauche, droite, haut, bas, etc.). 

 
Menu Outils 

Le menu « Tools » (Outils) est situé dans la barre de menu supérieure qui se trouve dans le 
coin supérieur gauche de l’écran principal. 

 
 
 

Preferences (Préférences) 
Le menu « Preferences » (Préférences) ouvre un utilitaire de gestion de la configuration qui 
peut être utilisé pour modifier diverses options ou paramètres. 

 REMARQUE : l’option de l’outil « Preference » (Préférence) est protégée par mot de passe 
et ne doit être accessible qu’à un représentant de service Hologic autorisé. 

 REMARQUE : la modification des paramètres de configuration sans connaissance ou 
autorisation appropriée peut entraîner une perte de qualité d’image, des dommages au système 
et un dysfonctionnement de ce dernier. 

 

 5.4.3 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.4.4 
Menu Outils 
 
 
Figure 5.4.19 
Menu Outils 
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Service Mode (Mode entretien) 
Le « Service Mode » (Mode entretien) est protégé par mot de passe et est activé par les 
techniciens autorisés de Hologic à des fins de dépannage. 

Service Tools (Outils d’entretien) 
L’option « Service Tools » (Outils d’entretien) est normalement grisée. Elle n’est activée que 
lorsque le système est en « Service Mode » (Mode entretien). 

Save Reference Files (Enregistrer les fichiers de référence) 
L’option « Save Reference Files » (Enregistrer les fichiers de référence) est normalement 
grisée. Elle n’est activée que lorsque le système est en « Service Mode » (Mode entretien). 

Options du menu Advanced Tools (Outils avancés) 
Le menu Advanced Tools (Outils avancés) propose diverses options pour configurer des 
aspects du logiciel tels que le post-traitement et les options de configuration. 

Auto Save On/Off (Enregistrement automatique Marche/Arrêt) 
Lorsque l’option « Auto Save » (Enregistrement automatique) est activée, toutes les images 
acquises ultérieurement sont enregistrées dans la base de données. Les fichiers sont 
enregistrés dans une donnée directement définie dans le fichier de configuration. 

X-Ray Calibration/Exposure Set-up (Étalonnage des rayons 
X/Configuration de l’exposition) 

Cet outil se trouve dans Advanced tools (Outils avancés). L’option « X-Ray 
Calibration/Exposure Set-up » (Étalonnage des rayons X/Configuration de l’exposition) aide 
l’utilisateur à déterminer le temps d’exposition approprié pour un réglage kV sélectionné afin 
d’obtenir une meilleure qualité d’image. Veuillez vous reporter à la Section 5.2.0 et à la 
Figure 5.2.1 pour une description plus détaillée.  

Preshot AEC Exposure Setup  
(Configuration de la pré-photo de l’exposition de l’AEC) 

Le système Faxitron Path utilise le contrôle automatique de l’exposition (AEC) pour fournir la 
meilleure qualité d’image possible par une simple pression sur le bouton Start X-Ray (Démarrer 
les rayons X). Le logiciel utilise une exposition Preshot (Pré-photo) pour calculer l’exposition 
optimale en kV et les paramètres de temps. La Preshot (Pré-photo) est une exposition courte, 
généralement de 2 à 3 secondes, aux rayons X. Le logiciel analyse les résultats pour déterminer 
le kV et le temps nécessaires pour produire la meilleure qualité d’image. La pré-photo de 
l’exposition de l’AEC est configurée à l’usine et est activée par défaut. 

« Preshot AEC Exposure Setup » (Configuration de la pré-photo de l’exposition de l’AEC) 
permet à l’utilisateur d’ajuster le système pour des besoins d’imagerie particuliers ou pour 
compenser le vieillissement du système. 

Pour accéder à la boîte de dialogue « Preshot AEC Exposure Setup » (Configuration de la pré-
photo de l’exposition de l’AEC), allez dans la barre de menu supérieure, sélectionnez « Tools » 
(Outils), « Advanced Tools » (Outils avancés) puis « PRESHOT AEC Exposure Setup » 
(Configuration de la PRÉ-PHOTO de l’exposition de l’AEC). Voir Figure 5.4.19. 

 5.4.4 Suite 
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Saisissez les valeurs d’AEC pour la 
PRÉ-PHOTO dans la fenêtre de 
droite. 
 
Les paramètres indiqués reflètent un 
temps d’exposition de 26 kV et de 
3 secondes avec une intensité cible 
de 10 000 ADU pour le paramètre de 
pré-photo. Les utilisateurs peuvent 
entrer dans la sélection des 
paramètres de pré-photo 
uniquement en sélectionnant 
DYNAMIC METHOD (MÉTHODE 
DYNAMIQUE) dans la section 
ANALYSIS METHOD (MÉTHODE 
D’ANALYSE). La sélection de 
STATIC METHOD (MÉTHODE 
STATIQUE) utilise les paramètres 
prédéfinis du Faxitron. De plus, 
l’utilisateur a la possibilité de 
sélectionner les réglages de kV et de 
temps d’exposition dans la section 
EXPOSURE TUNING METHOD 
(MÉTHODE DE SYNTONISATION 
DE L’EXPOSITION). 
 
Pour des images plus précises, 
l’utilisateur peut saisir l’épaisseur du 
TISSU MOU (échantillon) et 
l’INTENSITÉ CIBLE dans les ADU. 
REMARQUE : les valeurs indiquées 
dans l’image ci-dessus sont 
uniquement un exemple. La valeur 
correcte doit être déterminée. 
 

 Remarque : les valeurs dans l’image ci-dessus sont typiques du système Faxitron Path. 
Les valeurs exactes de votre système doivent être déterminées. 
 
Pour le mode AUTOMATIC EXPOSURE CONTROL (COMMANDE D’EXPOSITION 
AUTOMATIQUE), appuyez sur le bouton Start (Démarrer) du logiciel Vision (ou sur le panneau 
de commande). Le logiciel Vision effectue une pré-photo (courte, à faible dose, pré-exposition) 
de l’échantillon pour créer une région d’intérêt (ROI) afin d’obtenir les paramètres d’exposition 
permettant d’obtenir une exposition optimale de l’image. 

 5.4.4 Suite 
 
Figure 5.4.20 
Boîte de dialogue de 
configuration de la pré-photo de 
l’exposition de l’AEC 
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Utilitaire de connexion 
 
L’utilitaire de connexion se trouve dans le menu ADVANCED TOOLS (Outil avancés) et permet 
à l’utilisateur de configurer et d’activer l’authentification par mot de passe de démarrage pour 
le logiciel Vision. L’activation de cette fonction est facultative sur le système Faxitron Path. Si 
l’utilisateur active l’authentification par mot de passe, il sera invité à saisir le mot de passe à 
chaque ouverture du programme. Le programme se fermera si le mot de passe correct n’est 
pas saisi. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Properties (Propriétés) 
L’option « Properties » (Propriétés) masque ou affiche la boîte d’informations sur l’image. Voir 
Figure 5.3.9. 
 
Edit Current Image Record (Modifier le dossier d’image actuelle) 

Actuellement non utilisé. 
 

Delete Current Image Record  
(Supprimer le dossier d’image actuelle) 

Supprime l’image actuelle du répertoire de fichiers comme spécifié dans le fichier de 
configuration. 
 

Add Current Image Record  
(Ajouter un dossier d’image actuelle) 

Ajoute l’image actuelle au répertoire de fichiers comme spécifié dans le fichier de 
configuration. 
 

Capture Screen Shot JPG/BMP (Capture d’écran JPG/BMP) 
En sélectionnant ce choix dans le menu, l’utilisateur peut faire une capture d’écran de la 
fenêtre active affichée. L’utilisateur peut spécifier un nom de fichier et choisir entre les formats 
JPG et BMP pour enregistrer le fichier. 
 
Save / Store Current Image (Enregistrer/Stocker l’image actuelle) 

L’utilisateur peut « naviguer » vers le répertoire ou le dossier de fichiers dans lequel l’image 
doit être enregistrée. Un nom de fichier doit être attribué dans le champ prévu à cet effet. 
Sélectionnez un type de fichier pour l’option Enregistrer l’image sous. De nombreux types de 
fichiers sont disponibles. Pour enregistrer le fichier dans un format DICOM, reportez-vous à la 
section « Fonctionnalité DICOM ». 

Print Current Image (Imprimer l’image actuelle) 
Imprime l’image actuelle sur l’imprimante WINDOWS. 

 5.4.4 Suite 
 
 
 
 
 
 
 
Figure 5.4.21 
Utilitaire de connexion.  
Le même écran s’affiche 
lors de l’authentification au 
démarrage. 
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Outils image 
Les fonctions suivantes sont disponibles pour modifier l’image acquise ou récupérée en 
cliquant sur le menu « Image Tools » (Outils image). Voir Figure 5.4.22. Les options du sous-
menu sont activées ou accessibles par un simple clic sur l’option souhaitée. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Original Contrast (Contraste d’origine) 
L’option « Original Contrast » (Contraste d’origine) rétablit les niveaux de contraste de l’image. 
Elle a le même objectif que le bouton Original Contrast (Contraste d’origine) dans l’outil de 
niveau de la fenêtre et de contraste. Voir Section 5.4.1 et Figure 5.4.3. 

Invert (Inverser) 
L’option « Invert » (Inverser) provoque l’inversion ou le renversement de l’image affichée. 
L’inversion d’une image inverse sa transparence : ce qui est noir devient blanc et ce qui est 
blanc devient noir. Les gris se voient attribuer leur transparence « miroir ». Cliquez à nouveau 
sur « Invert » (Inverser) pour désactiver la fonction. Exécute la même fonction que le bouton 
Invert (Inverser). Reportez-vous à la Section 5.4.1 et aux Figures 5.4.3 et 5.4.4. 

 

5.4.5 
Outils image 
 
 
Figure 5.4.22 
Menu Image Tools (Outils image) 
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Magnify (Agrandir) 
L’option « Magnify » (Agrandir) permet à l’utilisateur d’agrandir une zone d’intérêt. Pour utiliser 
la fonction Magnify (Agrandir), placez le curseur de la souris sur la zone à agrandir et faites un 
clic gauche. La zone d’intérêt sera agrandie. Cliquez à nouveau sur « Magnify » (Agrandir) pour 
désactiver la fonction. Reportez-vous à la Figure 5.4.23. La taille de la zone d’intérêt agrandie 
peut être ajustée par l’utilisateur. Reportez-vous au sous-menu « Magnifier Size » (Taille de la 
loupe) de la Section 5.4.3. 

 

 

 

 

 

 

 

 

 

 

 

 

Edge Enhance (Amélioration des contours) 
L’option « Edge Enhance » (Amélioration des contours) crée une définition plus nette autour 
des contours des régions présentant une différence de contraste. D’une manière générale, 
l’amélioration des contours peut amplifier le bruit des images. En sélectionnant à nouveau cet 
élément dans le menu, vous désactivez l’amélioration des contours. Cliquer sur « Original 
Contrast » (Contraste d’origine) permet également de rétablir l’image dans son état d’origine. 
Notez qu’il s’agit d’une fonction différente de l’option Enhance Image (Améliorer l’image) décrite 
aux Sections 5.4.1 et 5.4.3. 

ROI Contrast (Contraste de la ROI) 
L’option « ROI Contrast » (Contraste de la ROI) permet d’optimiser les niveaux de contraste 
dans une région d’intérêt (ROI) définie par l’utilisateur. Après avoir sélectionné « ROI Contrast » 
(Contraste de la ROI), cliquez et maintenez le bouton gauche de la souris au point de départ 
de la ROI désirée, faites glisser la souris et relâchez le bouton de la souris au point final de la 
ROI désirée. Le contraste se règle automatiquement sur les meilleurs niveaux pour cette ROI. 
(Voir la Section Définitions pour la ROI) 

ROI Window Level (Niveau de fenêtre de la ROI) 
La fonction « ROI Window Level » (Niveau de fenêtre de la ROI) n’est pas disponible dans la 
version actuelle du logiciel Vision. 

 5.4.5 Suite 
 
 
 
 

Figure 5.4.23 
Magnify (Agrandir) 
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Ruler (Règle) 
L’option « Ruler » (Règle) permet à l’utilisateur de mesurer la distance entre deux points de 
l’image affichée. Les mesures de longueur sont en millimètres (mm). Après avoir sélectionné 
« Ruler » (Règle), cliquez et maintenez le bouton gauche de la souris enfoncé en commençant 
par le point de mesure, faites glisser la souris et relâchez le bouton de la souris au point de 
mesure final. La règle est affichée sous la forme d’une ligne rouge sur l’image. 
 
La mesure (en mm) s’affiche à 
l’extrémité de la règle. La règle 
reste active jusqu’à ce que 
l’utilisateur sélectionne un autre 
outil d’image ou jusqu’à ce qu’une 
autre action soit effectuée. Voir 
Figure 5.4.24 à droite. Cliquez à 
nouveau sur « Ruler » (Règle) 
pour désactiver la fonction. 
 
Astuce : pour obtenir une ligne 
parfaitement droite ou une ligne à 
un angle parfait de 45 degrés, 
maintenez la touche SHIFT 
enfoncée (sur le clavier) tout en 
maintenant le bouton gauche de la 
souris enfoncé en la faisant glisser. 
 

 

 
ROI Statistics (Statistiques de la ROI) 

« ROI Statistics » (Statistiques de la ROI) affichera une boîte de dialogue contenant des 
statistiques sur les images. Cliquez et maintenez le bouton gauche de la souris enfoncé sur la 
région d’intérêt (ROI) de l’image principale, faites glisser le curseur pour faire une sélection 
autour de la zone, puis relâchez le bouton de la souris. Les informations statistiques pour la 
région sélectionnée s’afficheront sur le côté gauche de la boîte de dialogue et pour l’image 
entière sur le côté droit de la boîte. Les statistiques affichées sont les suivantes : les points de 
début et de fin de la ROI, les valeurs d’intensité minimale, maximale et moyenne, et l’écart type 
(STD). Pour fermer la boîte d’information Statistics (Statistiques), il suffit de cliquer sur le bouton 
Close (Fermer). Voir Figure 5.4.25. Cliquez à nouveau sur « ROI Statistics » (Statistiques de 
la ROI) pour désactiver la fonction. 
 
 
 

 5.4.5 Suite 
 
 
 
 
 
 
 
Figure 5.4.24 
Ruler (Règle) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.25 
ROI Statistics (Statistiques de la 
ROI) 
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ROI Histogram (Histogramme de la ROI) 
« ROI Histogram » (Histogramme de la ROI) créera un histogramme pour une ROI définie par 
l’utilisateur. Après avoir sélectionné l’élément du menu, placez le curseur de la souris dans 
l’image affichée, appuyez sur le bouton gauche de la souris et maintenez-le enfoncé, puis faites 
glisser le curseur pour effectuer la sélection de la ROI souhaitée. Relâchez le bouton de la 
souris. Les histogrammes s’affichent pour la ROI sélectionnée. Voir Figure 5.4.6. 

La courbe noire est l’histogramme de la région sélectionnée. La courbe bleue est l’histogramme 
de l’image entière. Les deux courbes sont normalisées par rapport à la valeur maximale du 
pixel de la région d’intérêt sélectionnée. Cliquez à nouveau sur « ROI Histogram » 
(Histogramme de la ROI) pour désactiver la fonction. 

 

 

 

 

 

 

 

 

 

 

 

ROI Profile (Profil de la ROI) 
L’option « ROI Profile » (Profil de la ROI) crée un profil pour une ROI définie par l’utilisateur. 
Après avoir sélectionné l’élément de menu, placez le curseur sur l’image affichée. Maintenez 
le bouton gauche de la souris enfoncé et déplacez le curseur sur l’image pour dessiner un cadre 
défini par l’utilisateur autour de la ROI souhaitée. Relâchez le bouton gauche de la souris et un 
profil s’affichera donnant la valeur de pixel individuel de la ROI définie. Voir Figure 5.4.27. Par 
défaut, la direction de moyennage de la ROI sélectionnée est l’axe court. L’axe peut être changé 
en sélectionnant le bouton SWITCH, HOR<->VERT (BASCULER, HOR<->VERT). Cliquez à 
nouveau sur « ROI Profile » (Profil de la ROI) pour désactiver la fonction. 

 

 5.4.5 Suite 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.26 
ROI Histogram (Histogramme de 
la ROI) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.4.27 
ROI Profile (Profil de la ROI) 
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Line Profile (Profil de ligne) 
L’option « Line Profile » (Profil de ligne) affichera un profil pour une ligne définie par l’utilisateur. 
Après avoir sélectionné « Line Profile » (Profil de ligne), placez le curseur sur l’image affichée. 
Maintenez le bouton gauche de la souris enfoncé et déplacez le curseur sur l’image pour tracer 
une ligne définie par l’utilisateur. Relâchez le bouton gauche de la souris et un profil sera 
généré, affichant la valeur de pixel individuel de la ligne définie. Voir Figure 5.4.28. Par défaut, 
le premier point sélectionné est toujours la partie la plus à gauche (près de l’origine) du 
graphique (c’est-à-dire que l’axe horizontal du graphique peut avoir des indices de pixels (i,i) 
croissants ou décroissants, selon les points de début/fin sélectionnés). Cliquez à nouveau sur 
« Line Profile » (Profil de ligne) pour désactiver la fonction. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Built-In Window Level (Niveau de fenêtre intégré) 
Le logiciel Vision est livré avec une fonction de niveau de fenêtre « intégré ». Il n’y a aucun 
bouton ou élément de menu pour la sélectionner. La fonction « Niveau de fenêtre » est 
automatiquement activée chaque fois qu’une image est acquise ou récupérée de la base de 
données pour révision. Cette fonction permet à l’utilisateur de régler le contraste et la luminosité 
de l’image à l’aide de la souris/du curseur. 

Cliquez et maintenez le bouton gauche de la souris sur l’image affichée et déplacez le curseur 
vers le haut et vers le bas pour modifier les niveaux de luminosité/obscurité ou déplacez le 
curseur vers la gauche et vers la droite pour modifier les niveaux de contraste faible/élevé. 
Déplacez le curseur jusqu’à ce que l’image atteigne les niveaux souhaités. 

 5.4.5 Suite 
 
 
 
 
 
 
 
Figure 5.4.28 
Line Profile (Profil de ligne) 
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En appuyant sur le bouton, illustré à la Figure 5.5.1, situé en bas de la fenêtre d’acquisition 
d’image, la bande des vignettes d’images du patient actuel apparaît. Voir Figure 5.5.2. 
 
 
 
 
 
 

 
 
 
 
La bande des vignettes affiche la date de la procédure pour chaque série d’images individuelles 
en texte orange dans la partie supérieure. 

L’image actuelle affichée dans la fenêtre d’acquisition d’images sera surlignée en vert. 

La bande des vignettes est compatible avec les opérations de glisser-déposer pour placer les 
images dans la zone d’affichage des images ou dans les volets de révision, selon les besoins. 

De plus, d’un simple clic, l’utilisateur peut sélectionner plusieurs images puis choisir parmi 
différentes options pour enregistrer les images sur une clé USB, envoyer les images au PACS 
ou supprimer les images. Les images sélectionnées sont mises en surbrillance en orange. 

Des flèches s’affichent à gauche et à droite de l’écran. Dans le cas où de nombreuses images 
sont prises, l’utilisateur peut parcourir les images prises, par date croissante, en appuyant sur 
les flèches gauche/droite.  

L’option Open the Database (Ouvrir la base de données) (voir Figure 5.5.3) est aussi 
disponible et fait entrer en mode Review (Révision). Ce bouton équivaut à appuyer sur Review 
Mode (Mode Révision) dans le menu principal. Voir les Figures 5.0.1 et 5.6.1. 

 
 
Le mode Révision est accessible en cliquant sur le bouton Review (Révision) dans la page du 
menu d’accueil, Figures 5.6.1 et 5.0.1, ou sur le bouton Open Database (Ouvrir la base de 
données) dans le navigateur d’images actuelles. Voir Figure 5.5.3. En cliquant sur l’un ou l’autre 
de ces boutons, la base de données s’ouvrira comme indiqué dans la Figure 5.6.2. Le système 
sera en veille pendant le mode de révision. 
 
 
 
 
 
 
La base de données est essentiellement composée de trois sections ou sous-fenêtres. La 
section Patient List Table (Tableau de la liste des patients), à gauche, la section Procedure List 
Table (Tableau de la liste des procédures), en haut à droite, et la section Image Thumbnail 
List/Viewer (Liste/Visionneuse des vignettes d’images), en bas à droite. 

 

 5.5.0 
Navigateur pour 
les images du 
patient actuel 
Figure 5.5.1 
Icône du navigateur pour les 
images du patient actuel 
Figure 5.5.2 
Navigateur pour les images du 
patient actuel 
 
Figure 5.5.3 
Bouton de la base de données 
d’images 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.6.0 
Base de données 
 
 
Figure 5.6.1 
Icône du mode de révision 
affichée dans le menu d’accueil 
 
 
 
 
 
 
 
 
 
Figure 5.6.2 
Image Database (Base de 
données d’images) 
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Les tableaux des listes fonctionnent selon une hiérarchie descendante comme indiqué par la 
flèche : 

Liste des patients--->Liste des procédures--->Liste/Visionneuse des vignettes d’images. 

La fenêtre de sélection du patient est la fenêtre située la plus en haut à gauche. La fenêtre des 
procédures est la fenêtre située la plus en haut à droite. 

Lorsqu’un champ Patient est sélectionné, la fenêtre de procédure devient active. La fenêtre de 
procédure affiche une liste de toutes les procédures effectuées pour le patient sélectionné. De 
plus, toutes les images correspondant au patient sont affichées en bas à droite. Il n’est pas 
possible de sélectionner plusieurs patients. 

Lorsqu’une procédure est sélectionnée, la liste/visionneuse des vignettes est filtrée pour 
afficher uniquement les images correspondant à la procédure sélectionnée. Il est possible de 
sélectionner plusieurs procédures en maintenant la touche Majuscule enfoncée et en cliquant 
sur chaque procédure avec le bouton gauche de la souris. Toutes les images des procédures 
sélectionnées s’afficheront en conséquence. 

• Le tri de la base de données peut être réglé en cliquant sur les champs supérieurs tels que 
l’ID du patient et le nom de famille pour trier selon l’un ou l’autre des critères. Lorsqu’un clic 
de souris est fait sur l’un des champs de la base de données, une petite flèche s’affiche dans 
le champ. En utilisant le bouton gauche de la souris et en sélectionnant à nouveau le champ, 
le dessin de la flèche passe d’ascendant à descendant ou inversement. Le champ 
sélectionné sera automatiquement trié en conséquence. 

• Des barres de défilement sont situées dans la base de données pour faciliter la navigation. 

• La liste/visionneuse des vignettes permet à un utilisateur de cliquer sur le symbole « + » pour 
ajouter automatiquement l’image à un volet de révision. Un utilisateur peut ajouter jusqu’à 
quatre images dans les volets de révision. Les volets de révision sont automatiquement 
ajustés pour englober les quatre images. 

• Les mêmes options que celles disponibles dans le navigateur pour les images du patient 
actuel (voir Figure 5.5.2) se trouvent également en haut de la base de données. Toutefois, 
des options supplémentaires sont également disponibles ; elles sont décrites dans la 
Section 5.5.2. 

Remarque importante : les vignettes des images (.PNG) sont des fichiers distincts des fichiers 
de données d’images (DCM, DAT, DMM, RAW). Elles portent le même nom de fichier que le 
fichier d’image, mais elles ont une extension de fichier (.PNG). Il est possible d’avoir un fichier 
image mais pas de « vignette ». Dans ce cas, Vision tentera de créer automatiquement une 
vignette pour l’image qui doit être chargée dans la base de données. Cependant, si cette 
opération échoue, l’image ne sera pas affichée. 

 

Save Image(s) (Enregistrer la/les images[s]) 
Le bouton Save Image(s) (Enregistrer la/les image[s]) est disponible lorsqu’une entrée du 
tableau des images ou de la liste des vignettes est sélectionnée ou par le biais des images 
patient actuelles, sinon il est désactivé. L’image sélectionnée peut être enregistrée dans les 
formats 8 bits courants suivants : JPEG, BMP, TIFF et RAW. Elle peut également être 
enregistrée au format TIFF 16 bits. 

Le niveau de fenêtre de l’image enregistrée est le niveau de fenêtre par défaut. Si l’utilisateur 
souhaite que le niveau de la fenêtre soit modifié, il doit charger l’image dans Vue d’image et 
l’imprimer à partir de cet emplacement plutôt que de l’imprimer à partir de la boîte de dialogue 
de la base de données. 

 

Send Image(s) to PACS (Envoyer une/des image(s) au PACS) 
Cette fonction envoie une ou des images à un serveur PACS DICOM préconfiguré. Reportez-
vous à la Section 5.7.0 pour plus d’informations. 

 5.6.0 Suite 
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Fonctions et outils du menu de la base de données d’images 
Il existe des fonctions pour naviguer, rechercher dans la base 
de données et pour modifier, supprimer et ajouter des 
enregistrements à la base de données. Ces fonctions sont 
détaillées dans les éléments du menu de la base de données. 
On y accède à partir du bouton supérieur intitulé Additional 
Options (Options supplémentaires) dans la base de 
données. 

 

 

Menu Open (Ouvrir) 
Le menu « Open » (Ouvrir) ne comporte qu’une seule option « Open Image from File » (Ouvrir 
l’image du fichier) qui ouvre une boîte de dialogue Windows permettant à l’utilisateur de 
naviguer et d’ouvrir des fichiers image situés sur des lecteurs locaux ou en réseau. 

Menu Print (Imprimer) 
Le menu « DB-PRINT » (IMPRIMER BD) offre des fonctionnalités d’impression par image, par 
procédure et par patient. Voir Figure 4.6.4. 

 

 

 

Print Image to Local Printer  
(Imprimer l’image sur l’imprimante locale) 

L’élément « Print Image to Local Printer » (Imprimer l’image sur l’imprimante locale) est 
disponible lorsque la saisie à partir du tableau des images ou de la liste des vignettes est 
sélectionnée, sinon il est désactivé. L’image sélectionnée sera imprimée avec l’imprimante 
locale par défaut du système Windows. 

Le niveau de fenêtre de l’image imprimée est le niveau de fenêtre par défaut. Il n’est pas 
recommandé aux utilisateurs d’imprimer à partir de ce menu, sauf s’ils sont satisfaits des 
impressions définies avec les niveaux de fenêtre par défaut calculés par le programme. 
L’utilisateur peut d’abord charger l’image dans la fenêtre Image View (Vue d’image) (Révision) 
et ensuite régler l’image aux niveaux de fenêtre souhaités. Lorsqu’il est satisfait du niveau de 
la fenêtre, l’utilisateur peut alors lancer l’impression à partir du menu de la fenêtre Image View 
(Vue d’image). Une boîte de dialogue Format Options (Options de formats) permet de choisir 
entre les formats d’impression. 

Print Image(s) to DCM Printer  
(Imprimer la/les image[s] sur l’imprimante DCM) 

Cette fonction envoie la ou les images à une imprimante DICOM préconfigurée. 

Menu View (Affichage) 
Le menu « View » (Affichage) offre à l’utilisateur un certain nombre d’options affectant 
l’affichage de la base de données. Voir Figure 5.6.5. 
 
 
 
 
 

 5.6.1 
Options 
supplémentaires 
de la base de 
données 
 
Figure 5.6.3 
Menu d’options supplémentaires 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.6.4 
Menu d’impression de la base de 
données 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.6.5 
Menu d’affichage de la base de 
données 
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Show All DB Entries (Afficher toutes les entrées de la BD) 
Recharge le tableau Patient à partir du fichier de la base de données. Tout nouveau 
changement ou ajout à la base de données sera appliqué au tableau. Cette sélection efface 
également tout Search Filter (Filtre de recherche) actif qui aurait pu être appliqué aux tableaux. 
L’option Search Filter (Filtre de recherche) est expliquée en détail dans la partie Database 
Search (Rechercher dans la base de données) ci-dessous. 

Refresh DB Entries (Rafraîchir les entrées de la BD) 
Rafraîchit le tableau des patients, mais conserve tout Search Filter (Filtre de recherche) existant 
qui a été appliqué. 

Browse Data Directory (No DB)  
(Parcourir le répertoire des données [pas de BD]) 

Affiche toutes les vignettes d’images dans le répertoire des données établi par le fichier de 
configuration. Ces fichiers sont affichés dans la visionneuse de vignettes. Ils ne sont associés 
ni à la base de données, ni aux listes des tableaux. Cet outil est utile pour examiner les images 
non enregistrées ou pour déboguer les problèmes de base de données lorsque des images 
sont présentes dans le répertoire de données actuel. 

Browse Any Directory (No DB)  
(Parcourir n’importe quel répertoire [pas de BD]) 

Permet à l’utilisateur de naviguer dans n’importe quel répertoire de fichiers. Ces fichiers sont 
affichés dans la visionneuse de vignettes. Ils ne sont associés ni à la base de données, ni aux 
listes des tableaux. Cet outil est utile pour examiner un répertoire d’images qui n’a jamais été 
enregistré dans la base de données ou lorsque les enregistrements de la base de données sont 
corrompus. 

Menu Search (Rechercher) 
Les outils « Search » (Rechercher) de la base de données, voir Figure 5.6.6, permettent 
d’effectuer des recherches détaillées ou de filtrer la base de données. En sélectionnant le menu 
« DB-Search » (Rechercher dans la BD), l’utilisateur peut effectuer une recherche détaillée et 
spécifique. Lorsque le critère de recherche est saisi et activé dans la boîte de dialogue de 
recherche dans la BD, voir Figure 5.6.7, le filtre de recherche est appliqué à tous les tableaux 
de listes de la boîte de dialogue de la base de données d’image. Le critère de recherche activé 
est appelé Search Filter (Filtre de recherche) et ce filtre reste actif jusqu’à ce que l’utilisateur 
sélectionne « Stop Search » (Arrêter la recherche) dans le menu « DB-Search » (Rechercher 
dans la BD) ou « Show all DB Entries » (Montrer toutes les entrées de la BD) dans le menu 
« DB-View » (Afficher la BD). Le filtre de recherche actif est toujours affiché dans la légende de 
la boîte de dialogue de la base de données d’images. 
 

 

 

 

  

 5.6.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.6.6 
Menu de recherche dans la base 
de données 
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Start Search (Démarrer la recherche) 
« Start Search » (Démarrer la recherche) ouvre la boîte de dialogue de recherche dans la BD, 
ce qui permet de placer un filtre de recherche actif sur la base de données. Lorsque la boîte de 
dialogue de recherche est ouverte, la page de la base de données est fermée et le logiciel 
retourne à la page d’acquisition d’images. La page de la base de données se rouvrira 
automatiquement après la fermeture de la boîte de dialogue de recherche. 

 

 

 

 

 

 

Les menus déroulants proposent des listes de catégories de recherche. Sélectionnez une 
catégorie de recherche et saisissez le paramètre de recherche souhaité pour lancer la 
recherche. Sélectionnez « Start » (Démarrer) pour lancer la recherche. Si une catégorie a plus 
d’une entrée distincte, alors toutes les entrées de cette catégorie seront affichées. 

Stop Search (Arrêter la recherche) 
« Stop Search » (Arrêter la recherche) désactive tout filtre de recherche actif, efface tous les 
tableaux de listes et recharge la liste de tous les patients dans le tableau de la liste des patients. 

Menu Outils 
Le menu « DB-Tools » (Outils de BD) fournit des fonctions par image, par procédure, par 
patient, ainsi que des fonctions utiles pour réparer ou reformater la base de données. 

 

 

 

 

 

Edit Image Record (Modifier le dossier Image) 
La fonction « Edit Image Record » (Modifier le dossier Image) n’est pas disponible actuellement 
dans le logiciel Vision. 

Add Record to DB (Ajouter un dossier à la BD) 
Disponible lorsque la saisie à partir du Tableau des images ou de la Liste des vignettes est 
sélectionnée, sinon cette fonction est désactivée. Ceci est particulièrement utile lorsqu’un 
répertoire est parcouru alors que la base de données ne dispose d’aucune entrée pour les 
images dans ce répertoire. L’utilisateur peut sélectionner une seule image dans la liste des 
vignettes et ajouter des enregistrements de cette image dans la base de données. Si l’entrée 
de la base de données existe déjà pour l’image sélectionnée, il n’y a aucun danger, elle ne peut 
que mettre à jour la base de données en fonction de l’endroit où se trouve actuellement le fichier 
image, c’est-à-dire le nom du fichier/dossier. 

 

 5.6.1 Suite 
 
 
 
 
 
Figure 5.6.7 
Démarrage d’une RECHERCHE 
DANS LA BD 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.6.8 
Menu Tools (Outils) de la base de 
données 
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Import Records in DIR to DB  
(Importer des enregistrements de RÉP vers BD) 

Cet outil permet de parcourir et de sélectionner un dossier, puis de remplir la base de données 
avec toutes les entrées correspondantes pour tous les fichiers image dans le répertoire 
sélectionné (y compris les sous-répertoires). Les formats d’images peuvent être DCM, DAT, 
DMM et RAW. Si des vignettes d’images manquent, cet outil générera également des vignettes 
BMP dans le même répertoire. 

Reformat All DB (Reformater toute la BD) 
L’outil « Reformat All DB » (Reformater toute la BD) permet de reformater les champs Date 
[AAAA/MM/JJ], Date/Heure [AAAA/MM/JJ HH:MM:SS] des tableaux et de mettre en majuscules 
les lettres des entrées de certains autres champs. C’est un outil utile lorsqu’un ancien fichier de 
base de données est importé et ouvert pour la première fois ou lorsque l’utilisateur modifie 
manuellement les entrées de la base de données à l’aide de MS Access. 

 
Remarques supplémentaires sur la base de données 

• La possibilité de quitter la base de données, en restant dans le mode Review (Révision) se 
trouve dans Additional Options (Options supplémentaires). 

• Le bouton en haut à gauche se règle automatiquement pour ramener l’utilisateur à 
l’acquisition, ou au menu principal, ou il devient le bouton Close Database (Fermer la base 
de données) selon le flux de travail utilisé pour aller à l’écran de la base de données et ce 
qui est le plus approprié. 

 
Modifier ou supprimer des informations  

sur le patient de la base de données 
L’utilisateur peut modifier ou supprimer des informations sur le patient dans la base de données. 
Cliquez avec le bouton droit de la souris sur l’entrée du patient dans la partie supérieure de la 
base de données pour ouvrir une boîte de dialogue. Voir Figure 5.6.9. 

 

 

Cliquer sur « Edit Patient Information » (Modifier 
les informations sur le patient) ouvre une boîte de 
dialogue « Patient Information » (Informations sur 
le patient). Voir Figure 5.6.10. Cliquez sur Cancel 
(Annuler) pour revenir à la base de données sans 
effectuer ou enregistrer de modifications. Cliquer sur Save Changes (Enregistrer les 
modifications) ouvre une boîte de dialogue « Confirmation ». Cliquez sur Yes (Oui) pour 
confirmer et continuer. Les modifications sont maintenant enregistrées et l’utilisateur sera 
renvoyé à la base de données. No (Non) annulera les modifications et retournera à la base de 
données. Cancel (Annuler) renvoie l’utilisateur à la boîte de dialogue « Patient Information » 
(Informations sur le patient). 

 Remarque : si le système a un mot de passe de démarrage activé (voir la rubrique Utilitaire 
de connexion à la Section 5.4.4 et la Figure 5.4.21), le même mot de passe sera demandé lors 
de la tentative « Delete Patient Information » (Supprimer des informations sur le patient) de la 
base de données. 

 5.6.1 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.6.9 
Boîte de dialogue Edit/Delete 
(Modifier/Supprimer) (à gauche) 
 
Figure 5.6.10 
Informations sur le patient 
(à droite) 
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La norme DICOM 
Qu’est-ce que la norme DICOM ? 

La norme DICOM (Digital Imaging and Communications in Medicine) est une série de 
protocoles utilisés par les équipements et les logiciels médicaux pour permettre aux données 
d’être compatibles et interchangeables avec d’autres équipements ou logiciels médicaux. 

Lorsqu’un fichier est enregistré dans un format DICOM, un fichier est créé. Celui-ci comprend 
les données pertinentes du patient, les données de l’équipement d’imagerie, du matériel ainsi 
que les données d’image, le tout dans un seul fichier. De plus, le fichier enregistré contient des 
caractéristiques spécifiques qui permettent à l’ordinateur et au logiciel de l’identifier comme un 
fichier conforme à la norme DICOM. Une fois qu’une application logicielle reconnaît le fichier 
comme un fichier conforme à la norme DICOM, elle peut lancer un lecteur DICOM et extraire 
les données correctement, quelle que soit l’origine du fichier.  

Un fichier créé à l’aide du protocole DICOM a la structure suivante.  

 
 
 
 
 
 
 
Lorsque le préambule est constitué de 128 octets, tous sont 
généralement définis sur 00H, sauf s’il n’est pas utilisé par un 
profil d’application ou une implémentation spécifique ; le préfixe 
est constitué de 4 octets, constituant la chaîne de caractères 
« DICM » codée en majuscules du répertoire de caractères G0 
de la norme ISO 8859 ; les éléments de données sont 
arbitrairement grands (ou petits) et contiennent les données. 

 

Modalité 
Les paramètres du fichier DICOM pour la modalité sont accessibles à partir de la barre de menu 
supérieure en sélectionnant « DICOM Utilities » (Utilitaires DICOM), puis « DICOM Modality 
Setup » (Configuration de modalité DICOM). 

 

 

 

Le type de stockage DICOM, soit Présentation soit Traitement, peut être sélectionné. La même 
boîte de dialogue permet de sélectionner la modalité d’image DICOM, soit radiographie 
numérique soit mammographie numérique. Les paramètres « Transfer Syntax » (Syntaxe de 
transfert) et « Value Representation » (Représentation de valeur) ne peuvent pas être définis 
par l’utilisateur. Ils sont toujours paramétrés sur META HEADER PRESENT, LITTLE_ENDIAN 
et VR_IMPLICIT. 

 

5.7.0 
Fonctionnalité 
DICOM 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.7.1 
Structure du protocole DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.2 
Menu DICOM Utilities (Utilitaires 
DICOM) 
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 REMARQUE : une fois les modalités DICOM sélectionnées, elles restent en vigueur, même 
après la fermeture du logiciel Vision. Les paramètres de la modalité sont stockés et resteront 
mémorisés dans la configuration jusqu’à ce qu’ils soient modifiés à nouveau, en utilisant les 
paramètres du fichier DICOM. Ces paramètres (de type de stockage et de modalité, de syntaxe 
de transfert, et de représentation des valeurs) seront effectifs pour toutes les fonctionnalités 
DICOM « Local Save » (Enregistrer en local) ou « Local Print » (Imprimer en local). 

Default DICOM Servers (Serveurs DICOM par défaut) 
Cette section contient des paramètres pour les serveurs DICOM par défaut et pour automatiser 
certains des processus lors du stockage, de l’impression ou de la recherche de serveurs PACS 
et MWL. 

Les cases à cocher « Enable Single-Click Auto Store » (Activer le stockage automatique en un 
seul clic), « Print » (Imprimer) ou « MWL Connection » (Connexion MWL) permettent à 
l’utilisateur de stocker ou d’imprimer des images ou de se connecter automatiquement au 
serveur MWL. Si vous utilisez un seul serveur PACS pour ces actions ou si la majorité de votre 
travail concerne un seul serveur PACS, cochez la case souhaitée pour automatiser ces actions. 

La case « Enable Auto Search When Connecting to MWL Server » (Activer la recherche 
automatique lors de la connexion au serveur MWL) indique à l’application d’effectuer 
automatiquement une recherche avec les paramètres de recherche par défaut lors de la 
recherche des données des patients. 

 

 

 5.7.0 Suite 
 
Figure 5.7.3 
Paramètres de Modalité DICOM  
Paramètres par défaut 
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La case « Auto close dialog after N seconds of successful transfer/printing » (Fermeture 
automatique de la boîte de dialogue après N secondes de transfert/impression réussi[e]) ferme 
automatiquement la boîte de dialogue du réseau DICOM après un nombre de secondes 
spécifié. La boîte de dialogue ne se ferme pas automatiquement en cas d’erreur de transfert ou 
d’impression. 

Cliquer sur le bouton DICOM Servers (Serveurs DICOM) ouvre la boîte de dialogue réseau 
DICOM où un utilisateur peut ajouter, modifier ou supprimer des serveurs DICOM. Voir 
Figure 5.7.5. 

DICOM Save Local (Enregistrer DICOM en local) 
Pour enregistrer l’image actuelle sur un lecteur local/répertoire, cliquez avec le bouton droit de 
la souris n’importe où dans l’image. Cela affichera la boîte de dialogue présentée dans la 
Figure 5.7.4 ci-dessous. Cliquez sur « Save/Store current image » (Enregistrer/Stocker l’image 
actuelle) puis sur « As Local DICOM image » (En tant qu’image DICOM locale). Cela fera 
apparaître la boîte de dialogue standard d’enregistrement de fichiers de Windows. Naviguez ou 
cliquez sur le répertoire/dossier souhaité, entrez le nom du fichier et cliquez sur Save 
(Enregistrer). 

 

 

 

 

PACS STORE (ENREGISTREMENT PACS) et PACS PRINT 
(IMPRESSION PACS) 

Le logiciel Vision permet l’enregistrement PACS (DICOM) et l’impression PACS (DICOM). Ces 
options sont disponibles dans l’ensemble du logiciel. Par exemple, si le bouton PACS Store 
(Enregistrement PACS) est sélectionné, la fenêtre de dialogue suivante avec le réseau DICOM 
peut être affichée. Cette boîte de dialogue permet à l’utilisateur d’effectuer un enregistrement 
DICOM, d’effectuer une impression DICOM, ou d’ajouter, de modifier ou de supprimer des 
connexions réseau ou des périphériques DICOM. 

 5.7.0 Suite 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.4 
Boîte de dialogue Save Current 
Image (Enregistrer l’image 
actuelle) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.5 
Boîte de dialogue DICOM 
Networking (Réseau DICOM) 
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PACS DICOM STORE (ENREGISTREMENT PACS DICOM) 
Le logiciel Vision prend en charge le service C-STORE DICOM 3.0. Ceci permet d’envoyer une 
image ou une série d’images (selon une procédure spécifiée) à un système de stockage distant 
conforme à l’entité d’application (AE) DICOM, comme le PACS. Là encore, la fonction DICOM 
Store (Enregistrement DICOM) est accessible dans l’ensemble du logiciel Vision. Les 
modifications de la présentation et du traitement peuvent être effectuées par le biais de la 
configuration de la modalité DICOM, dans le menu Tools (Outils).  

 Remarque : pour l’enregistrement DICOM, la case « SET FILM Attributes » 
(PARAMÉTRER les attributs du film) est grisée.  

L’utilisateur peut ajouter une nouvelle configuration pour une AE DICOM distante à laquelle 
envoyer l’image ou choisir parmi une configuration déjà existante, affichée dans Connexions 
réseau DICOM, dans la boîte de dialogue DICOM Networking (Réseau DICOM). En double 
cliquant (ou avec un seul clic et en appuyant sur le bouton Connect) sur l’icône de l’AE DICOM 
distante, le logiciel Vision se connecte et établit une association DICOM avec l’AE distante 
sélectionnée. Une fois que l’association réussie, l’image peut être envoyée pour être 
enregistrée en appuyant sur le bouton Store (Enregistrer). Après avoir sélectionné le bouton 
Store (Enregistrer), le logiciel Vision envoie l’image sélectionnée à l’AE DICOM distante définie. 
Si l’opération de mémorisation est réussie, l’AE DICOM distante envoie une confirmation de 
réception et d’enregistrement de la ou des images. Si l’opération échoue, l’AE DICOM distante 
enverra un code d’erreur indiquant la raison de l’échec. 

Une seule image peut également être envoyée pour être enregistrée en cliquant avec le bouton 
droit de la souris sur la vignette de l’image (dans le navigateur de la base de données) et en 
suivant la même procédure que celle décrite précédemment. Il est possible d’envoyer toute une 
série (Procédure) d’images pour enregistrement. Pour ce faire, cliquez avec le bouton droit de 
la souris sur le nom de la série (Procédure), affiché dans l’écran du navigateur de base de 
données, puis suivez le même protocole que celui décrit ci-dessus. 

Add Session (Ajouter une session) 
Le bouton Add Session (Ajouter une session) ouvre la boîte de dialogue de session par 
laquelle l’utilisateur peut configurer une nouvelle connexion à une entité d’application DICOM 
distante. 

Pour créer une nouvelle configuration de connexion à une AE DICOM distante, l’utilisateur doit 
disposer des informations suivantes : le titre de l’entité d’application (AE Title), le choix de la 
« fonction à exécuter » DICOM/PACS, l’adresse IP et le numéro de port du serveur (c’est-à-
dire de l’imprimante DICOM ou du système PACS). 

Le titre AE et le numéro de port du système de l’utilisateur (c’est-à-dire le client) sont également 
nécessaires. Remplissez les champs de données correspondants et sélectionnez OK pour 
créer une nouvelle configuration. 

 

 

 

 

 

 

 

 

 

 

 

 5.7.0 Suite 
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Choix du comportement de la fonction  
de session DICOM/PACS par défaut 

Il y a actuellement quatre (4) types de fonctions qu’une session DICOM peut utiliser par défaut. 
Celles-ci se trouvent dans la liste déroulante Fonctions (cases combinées) comme indiqué dans 
les figures ci-dessous. La liste est la suivante : 

1. Connexion GENERAL (GÉNÉRALE) 
DICOM/PACS. 

2. Connexion STORE (ENREGISTREMENT) 
DICOM. 

3. Connexion PRINTER (IMPRIMANTE) 
DICOM. 

4. Connexion WORKLIST (LISTE DE 
TRAVAIL) de la modalité. 

 
 
 
 
 
 
 
Le but de la « Fonction » DICOM est de permettre la création (l’ajout) d’une Session/Connexion 
qui à son tour permet d’utiliser un « dispositif » DICOM/PACS uniquement tel que l’utilisateur 
l’a configuré pour une catégorie de fonctions particulière. Une fois configuré, lorsque vous 
visualisez ou utilisez la « DICOM Networking Dialog » (Boîte de dialogue réseau DICOM) (voir 
Figure 5.7.5 ci-dessus), seule l’icône correspondant à la fonction choisie sera « active et 
illuminée ». C’est-à-dire qu’elle aura une couleur bleue par opposition à une couleur « grisée ». 
Par exemple, dans la Figure 5.7.5 ci-dessus, il y a trois (3) icônes représentant, dans l’ordre : 
un enregistrement PACS (DICOM Store 1), une impression PACS (DICOM Print 1) et une liste 
de travail des modalités (DICOM-MWL). Comme l’icône DICOM Store (Enregistrement 
DICOM) a été choisie précédemment, elle est la seule active (écran bleu). Les autres modes 
fonctionnent de la même manière. 

Modify Session (Modifier la session) 
Le bouton Modify Session (Modifier la session) ouvre la boîte de dialogue pour l’AE DICOM 
sélectionnée. Dans cette fenêtre, l’utilisateur peut modifier les informations du serveur et du 
client décrites dans la partie Add Session (Ajouter une session). 

Remove Session (Supprimer la session) 
Le bouton Remove Session (Supprimer la session) supprime la configuration de l’AE DICOM 
sélectionnée du logiciel Vision. Une fois supprimée, une configuration AE DICOM ne peut pas 
être restaurée, sauf si l’utilisateur saisit à nouveau manuellement les données requises par le 
biais du bouton Add Session (Ajouter une session). Une confirmation d’action sera demandée, 
voir ci-dessous. 

 
 
 
 
 
 
 
 
 
 

5.7.0 Suite 
 
 
 
 
 
Figure 5.7.6 
Boîte de dialogue Session 
Properties (Propriétés de la 
session) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.7.7 
Vérification de la suppression 
d’une connexion réseau DICOM 
existante 
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Association 
Le bouton Association List (Liste des associations) ouvre la boîte de dialogue Association, 
représentée ci-dessous, grâce à laquelle l’utilisateur peut modifier les paramètres et les 
protocoles utilisés par le logiciel Vision lors de la négociation d’une connexion avec une AE 
DICOM distante. Ces options doivent être modifiées uniquement par un utilisateur avancé, 
familiarisé avec les protocoles d’association DICOM. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Attributs du film 
En sélectionnant « Set DICOM Print Film Attributes » (Paramétrer les attributs d’impression du 
film) dans le menu « Command » (Commande) (Figure 5.7.9), la boîte de dialogue de 
configuration de l’imprimante DICOM s’affiche. Voir Figure 5.7.10. Dans cette boîte de dialogue, 
l’utilisateur peut sélectionner diverses options régissant le film et le format d’impression. La 
sélection de l’option Default (Par défaut) rétablit toutes les options par défaut. Les 
configurations des paramètres sont accessibles via des menus déroulants. Pour accepter la 
configuration modifiée, sélectionnez OK. Pour rejeter les options et quitter la fenêtre sans 
apporter aucun changement, sélectionnez Cancel (Annuler). 

 
 

 5.7.0 Suite 
 
 
 
 
 
 
 
Figure 5.7.8 
Fenêtre Association DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.7.9 
Paramétrer les attributs 
D’IMPRESSION DU FILM DICOM 
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PACS PRINT (IMPRESSION PACS) 
L’option PACS Print (Impression PACS) envoie l’image sélectionnée à l’imprimante PACS 
DICOM sélectionnée. L’image est imprimée selon les options de format de film et d’impression 
spécifiées dans la boîte de dialogue Set Film Attributes (Configurer les attributs du film) décrite 
précédemment. Si l’utilisateur lance l’impression PACS à partir de Image View (Vue image), 
alors le niveau de la fenêtre sera choisi dans cette vue image. Si l’impression PACS est lancée 
à partir de la boîte de dialogue Base de données, alors le niveau de la fenêtre sera le niveau 
de fenêtre par défaut calculé par le logiciel Vision. 

 

Close (Fermer) 
Le bouton Close (Fermer) ferme la boîte de dialogue DICOM Networking (Réseau DICOM) et 
fait revenir l’utilisateur dans la zone à partir de laquelle la commande DICOM a été exécutée. 
Cette commande ferme également la connexion ou l’association entre le logiciel Vision et le 
périphérique DICOM distant si une connexion a été établie. 

 5.7.0 Suite 
 
Figure 5.7.10 
Boîte de dialogue de 
configuration de l’imprimante 
DICOM 

 



 
 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 001  

SECTION 
Logiciel Vision 5 

5-41 

Faxitron® Path 
Système de radiographie d’échantillons 

Vue d’ensemble 
L’option User Annotations (Annotations de l’utilisateur) dans le logiciel Vision permettent 
d’appliquer une « superposition » graphique transparente sur une image, communément 
appelée « annotations ». Ces annotations peuvent être un texte, des lignes, des lignes de 
« forme libre » (courbes de Bézier), des flèches, des ellipses et des boîtes. Cela permet 
d’ajouter des informations supplémentaires et des « marqueurs » sur l’image si besoin. Notez 
que toutes les annotations peuvent être facilement activées ou désactivées, en d’autres termes, 
elles peuvent être affichées ou masquées à volonté. 

 

Opérations 
Pour commencer l’annotation, sélectionnez l’outil Annotations dans le menu de gauche. Voir 
les Figures 5.4.1 et 5.8.1. En ouvrant cette boîte de dialogue, le logiciel met immédiatement 
l’utilisateur en mode conception. Il affichera aussi une « palette d’outils ». Voir Figure 5.8.2 
ci-dessous.  
 

 

 

Le fait de sélectionner Save (Enregistrer) ou Cancel (Annuler) dans cette boîte de dialogue 
annulera les annotations précédentes ou enregistrera les annotations actuelles dans la fenêtre. 
Il vous ramènera également au mode d’imagerie normal. 

La palette d’outils est composée des quinze (15) options d’outils suivants. Cependant, les outils 
peuvent être tronqués aux 8 outils les plus courants, en fonction des besoins de l’utilisateur ; ils 
sont affichés dans la ligne supérieure de la boîte de dialogue.  

Notez que le comportement de la plupart de ces options d’outils implique l’utilisation de la souris 
pour guider la position et la forme dynamiques à l’écran. Les « clics » de la souris sont utilisés 
pour définir les positions et les formes finales. Le terme « balayer » signifie que l’on maintient 
le bouton gauche de la souris enfoncé et que l’on déplace l’objet sur l’écran. Le fait de relâcher 
le bouton gauche de la souris ou de cliquer sur le bouton droit de la souris mettra l’annotation 
en position « permanente » ou finale. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 5.8.0 
Annotations de 
l’utilisateur 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.8.1 
Icône d’annotations 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.8.2 
Palette d’outils de conception des 
annotations de l’utilisateur 
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En commençant dans le coin supérieur gauche de la Figure ci-dessus, une description de 
chaque option d’outil est donnée ci-après. 

• Outil de sélection : utilisez cet outil pour sélectionner (mettre en surbrillance) un objet 
d’annotation courant. Cliquez et maintenez le bouton gauche de la souris enfoncé, ce qui 
définit une position de départ, puis déplacez la souris. Les annotations qui se trouvent à 
l’intérieur de la boîte affichée seront sélectionnées pour une utilisation ultérieure. Relâchez 
le bouton gauche de la souris pour terminer l’opération. 

• Outil ligne : cette option permet de tracer une ligne droite. Le comportement de la souris est 
le même que ci-dessus. 

• Outil boîte : dessine une boîte. Le comportement de la souris est le même que ci-dessus. 

• Outil ellipse (et cercle) : dessine une ellipse ou un cercle. Le comportement de la souris est 
le même que ci-dessus. 

• Outil flèche : dessine une ligne avec une flèche à son extrémité. Le comportement de la 
souris est le même que celui de l’outil ligne. 

• Outil ligne ouverte de polygone : dessine des lignes non droites « à segments ouverts ». 
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relâchez 
le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que désiré. Cliquez 
sur le bouton droit de la souris et le fonctionnement de l’outil se termine. 

• Outil texte : crée une « zone de texte » où vous pouvez saisir des données sous forme de 
texte. 

• Outil règle : crée un segment de ligne gradué. Très similaire à la fonction Règle des outils 
d’image. 

• Outil ligne fermée de polygone : dessine des lignes non droites « à segments fermés ». 
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relâchez 
le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que désiré. Cliquez 
sur le bouton droit de la souris et le fonctionnement de l’outil se termine. 

• Outil ligne courbe ouverte : dessine des lignes courbes « ouvertes et segmentées ». 
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, 
dessinez. Relâchez le bouton de gauche, cela définit un segment de ligne courbe. Répétez 
autant de fois que désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de 
l’outil se termine. 

• Outil ligne courbe fermée : dessine des lignes courbes « fermées et segmentées ». 
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, 
dessinez. Relâchez le bouton de gauche, cela définit un segment de ligne courbe. Répétez 
autant de fois que désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de 
l’outil se termine. 

• Outil infobulle (texte) : crée une zone de texte avec un segment de ligne dépassant d’un 
coin de la zone de texte. Ceci peut être utilisé pour « relier » le texte à un élément sur votre 
image. 

• Règle segmentée : dessine des lignes graduées non droites « ouvertes et segmentées ». 
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relâchez 
le bouton gauche, ceci définit un segment de ligne gradué. Répétez autant de fois que désiré. 
Cliquez sur le bouton droit de la souris et le fonctionnement de l’outil se termine. La longueur 
de tous les segments de ligne gradués est indiquée à l’extrémité de la règle. Utile pour une 
estimation approximative de la circonférence d’un objet ou d’un patient. 

• Outil rapporteur : dessine un angle sur l’écran et indique la valeur de l’angle en degrés. 
Comme un rapporteur. 

• Outil règle orthogonale : crée deux (2) lignes graduées orthogonales (l’une par rapport à 
l’autre).  

 5.8.0 Suite 
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Mode de conception et menu contextuel (clic droit de la souris) 
 
En mode User Annotation Design Mode (Conception des annotations de l’utilisateur), mais pas 
dans un mode de fonctionnement spécifique, il est possible de faire un clic droit de la souris 
pour afficher un menu contextuel. Voir ci-dessous. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
De nombreux réglages spécifiques peuvent être effectués à partir de ces menus contextuels. 
 

 Remarque : si un élément semble trop petit pour être lu ou vu correctement, vous pouvez 
éventuellement le modifier à partir des menus contextuels présentés ci-dessus. Vous pouvez 
également choisir de zoomer dans l’image à l’aide de l’outil Dynamic Zoom (Zoom dynamique). 
Ceci agrandit l’image et vous devriez pouvoir voir clairement toutes les annotations. 
 
 

Afficher/Masquer les annotations 
 
Le bouton Toggle Annotations (Basculer les annotations) illustré à la Figure 5.8.4, 
permet aux utilisateurs d’activer et de désactiver rapidement les annotations. Par 
défaut, les annotations seront activées. Le bouton est situé dans le menu de droite, 
près du coin supérieur droit. 
 
 
 
Le sous-menu « Help » (Aide), voir Figure 5.9.1, est situé sur la barre de menu supérieure et 
permet d’accéder rapidement au « User’s Manual » (Manuel de l’utilisateur) Faxitron Path et à 
« About Vision » (À propos de Vision). Voir Section 5.10.0 et Figure 5.10.1. 
 
 
 
 

 5.8.0 Suite 
 
 
 
 
Figure 5.8.3 
Menu contextuel de la souris (clic 
droit) (uniquement en mode de 
conception des annotations de 
l’utilisateur) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.8.4 
Option Show/Hide 
(Afficher/Masquer) pour les 
annotations de l’utilisateur 
 
 
 
5.9.0 
À propos de l’Aide 
 
 
Figure 5.9.1 
Boîte de dialogue de l’aide en 
ligne 
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Le bouton About Vision (À propos de Vision) ouvre une boîte de dialogue qui affiche la version 
du logiciel Vision, la date de copyright et les informations sur le système. 
 

 5.10.0 
À propos du 
logiciel Vision 
 
Figure 5.10.1 
Boîte de dialogue d’informations 
About Vision (À propos du logiciel 
Vision) 
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SECTION 6 
Exigences de conformité et 

mesures de sécurité 
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Exigences | Conformité de Faxitron Path 
 
Limites en émission 
Le rayonnement émis par l’unité Faxitron Path+ ne dépasse pas une exposition de 0,1 milli-
Roentgen (mR) par heure en un point quelconque situé à 5 centimètres (cm) à l’extérieur de 
la surface externe. Pour les pays exigeant des valeurs d’émission mesurées à 10 cm des 
surfaces externes, le rayonnement ne dépasse pas 0,1 mR par heure à 10 cm. 
 
Verrouillages de sécurité 
Le système DR d’échantillons Faxitron Path est doté de deux verrous de sécurité situés sur la 
porte du compartiment à échantillon. 
 
Bouton de démarrage 
Après l’interruption de la génération de rayons X par les verrouillages de sécurité, le bouton 
Start (Démarrage) du panneau avant reprendra la génération de rayons X lorsque le système 
sera prêt. 
 
Commande par clé 
Interrupteur à clé situé sur le panneau avant, qui nécessite d’insérer une clé et de la tourner 
dans le sens des aiguilles d’une montre jusqu’à la position « 3 heures » pour mettre sous 
tension le système de l’armoire. La clé ne peut pas être retirée en position « MARCHE ». 
 
Bouton d’arrêt d’urgence 
Le bouton d’arrêt d’urgence du panneau avant du Faxitron Path permet de mettre fin à la 
génération de rayons X. C’est un élément supplémentaire qui s’ajoute aux verrouillages de 
sécurité des portes du système. 
 
Voyants de génération de rayons X 
Le Faxitron Path est doté d’un voyant lumineux d’activation de rayons X sur le panneau avant 
et sur l’interface utilisateur graphique ; il émet également un signal sonore pendant la 
génération de rayons X. 
 
Puissances nominales 
100–240 50/60 HZ 200 W MAX. 
 
Production de chaleur 
500 BTU/h MAX. 
 
LOCALISATEUR LASER 
Le Faxitron Path utilise une paire de lignes générées par laser pour aider à positionner les 
échantillons au milieu du champ d’imagerie.  
 
Paramètres des lasers 
Les lasers sont conformes à la norme CEI 60825-1:2007. 
Produits laser de classe 2. 
Longueur d’onde :  670 nm. 
Puissance de pointe :  2 mW. 
Largeur des lignes :  1 mm standard. 
Divergence des faisceaux :  85º standard. 
 
Les lasers ne nécessitent aucun assemblage. 
 
L’opérateur n’est pas autorisé à effectuer des opérations de maintenance sur les lasers. Les 
lasers doivent être entretenus uniquement par un représentant autorisé de Hologic. 
 
PARAMÈTRES ÉLECTRIQUES DES LASERS 
Tension de fonctionnement :  Rouge : 3-6VDC. 
 Noir :  terre. 
Courant de fonctionnement :  50 mA standard. 
 80 mA MAX. 

 6.1.0 
Exigences de 
conformité et 
mesures de 
sécurité 
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MISES EN GARDE :   
RAYONNEMENT LASER DE CLASSE 2 LORSQUE LA PORTE EST OUVERTE. NE FIXEZ 
PAS LE FAISCEAU.  
 
Un rayon laser peut être dangereux pour les yeux. NE REGARDEZ PAS dans l’ouverture du 
laser lorsque celui-ci est en fonctionnement. 
 
La lumière laser peut également être dangereuse lorsqu’elle est réfléchie sur une surface 
similaire à un miroir. 
 
Pour plus d’informations sur la sécurité des lasers, consultez la norme ANSI-Z1 36.1 
STANDARD FOR THE SAFE USE OF LASERS, disponible auprès du Laser Institute of 
America, téléphone 407-380-1553. 
 

 REMARQUE :  les ouvertures du laser sont situées dans le plafond de la chambre à 
rayons X. 
 
 
 
Étiquette de MISE EN GARDE de laser :  située dans le coin supérieur droit de la porte. 

 
 
 
 
 

 6.1.0 Suite 
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Version DICOM 
 
Hologic utilise la dernière norme DICOM : 
ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, version finale, 
août 1993. 
 
Et est conforme à :  
NEMA PS 3.1 — 3.20 (2016), Digital Imaging and Communications In Medicine Set. 
 
 
Classes de stockage 
 
FAXITRON_DR fournit une conformité standard à la classe DICOM V3.0 SOP suivante en 
tant que SCU. 
 
Classe SOP du SCU 

 
Classe SOP UID de la classe SOP 

Computed Radiography Image Storage SOP 1.2.840.10008.5.1.4.1.1.1 
Digital X-ray Image Storage Presentation 1.2.840.10008.5.1.4.1.1.1.1 
Digital X-ray Image Storage Processing 1.2.840.10008.5.1.4.1.1.1.1.1 
Digital X-ray Mammography Image Storage Presentation 1.2.840.10008.5.1.4.1.1.1.2 
Digital X-ray Mammography Image Storage Processing 1.2.840.10008.5.1.4.1.1.1.2.1 
Study Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.2.1 
Patient Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.1.1 
Modality Worklist information Model-FIND 1.2.840.10008.5.1.4.31 
Greyscale Softcopy Presentation Storage 1.2.840.10008.5.1.4.1.1.11.1 

 
 

Pour plus de détails, consultez la déclaration de conformité « Full DICOM » enregistrée sur le 
système. Le fichier se trouve dans C:\Faxitron et un raccourci est fourni sur le bureau.  
 
Si nécessaire, une copie de la déclaration de conformité DICOM est disponible sur demande 
auprès de Hologic. 

 6.2.0 
Norme DICOM 
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Entretien 
 
L’équipement Hologic ne contient aucune pièce réparable. Veuillez contacter votre 
représentant Hologic agréé pour toute réparation.  
 
États-Unis : +1.877.371.4372 

Europe : +32 2 711 4690 

Asie : +852 37487700 

Australie : +1 800 264 073 

Autres pays : +1 781 999 7750 

Courrier électronique : BreastHealth.Support@hologic.com 

 
Dépannage 
 
L’ordinateur ou le système ne s’allume pas 
Pas d’alimentation électrique de l’ordinateur ou du système de radiographie.  
Vérifiez que le système est sous tension (MARCHE) et que la fiche d’alimentation est 
branchée et sous tension. 
 
Le voyant READY (PRÊT) ne reste pas sur « activé » 
Le bouton a été pressé AVANT que le logiciel Vision ne soit lancé ou avant que le logiciel 
n’arme le système de radiographie pour une acquisition. Voir Démarrage rapide. 
 
L’image semble indiquer qu’il y a un autre objet dans l’unité de rayons X 
Vérifiez que pendant l’étape « Étalonnage », aucun autre objet n’était présent dans l’armoire 
à rayons X. Retirez les objets et répétez l’étape Étalonnage. 
 
Mauvaise qualité des images  
Vérifiez que les valeurs d’intensité de l’image (I (x,y)) qui se trouvent dans le coin inférieur 
droit de la fenêtre d’affichage de l’image sont proches de la valeur ADU cible de 10 000. 
lorsque la cible DE pré-photo de l’exposition de l’AEC est également fixée à 10 000 ADU et 
que le mode d’exposition est Auto kV/Auto Time. Si nécessaire, répétez la procédure 
d’Imagerie. 
 
 
Cybersécurité 
Si un événement lié à la cybersécurité se produit, déconnectez le système du réseau et 
contactez immédiatement Hologic. Nous travaillerons avec votre département informatique 
pour résoudre le problème. 
 
Un événement lié à la cybersécurité peut être détecté de plusieurs façons : 

• Fonctionnement et/ou connexion au réseau plus lents que la normale. 

• Fenêtres contextuelles suspectes ou page d’accueil modifiée dans le navigateur 
Internet. 

• Mot(s) de passe inopérant(s). 

• Programmes non identifiés dans le menu de démarrage ou dans la barre d’état du 
système. 

• Données manquantes, corrompues ou altérées. 

 7.1.0 
Entretien et 
dépannage  
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Ce document fournit un calendrier de tests et de maintenance pour le Faxitron Path. Il est 
fortement recommandé que l’entretien et les tests décrits dans cette section soient effectués 
en respectant les intervalles de temps indiqués, pour s’assurer que votre générateur de rayons 
X Faxitron continue à fonctionner avec des performances optimales. 

 8.0.0 
Maintenance 
 

 
Avertissement : les échantillons contenant des tissus peuvent abriter des agents 
infectieux dangereux pour votre santé. Respectez les procédures de biosécurité 
appropriées ; portez des gants lors de la manipulation des échantillons de tissus 
ou des matériaux avec lesquels ils sont entrés en contact. 
 
Essuyez régulièrement l’intérieur de l’armoire avec de l’alcool isopropylique à 70–90 % ou avec 
de l’hypochlorite de sodium dilué (5,25–6,15 % d’eau de Javel domestique diluée à 1:500 
fournit la concentration appropriée). Veillez à ce que la zone de l’échantillon, indiquée sur le 
sol de la chambre, soit nettoyée à fond. 
 
N’utilisez pas d’acétone ou d’autres solvants agressifs sur la fenêtre de la porte de la chambre 
à rayons X. 
 

  
8.1.0 
Interne 

 
Essuyez régulièrement les surfaces externes avec de l’alcool isopropylique, de l’hypochlorite 
de sodium ou du savon doux et de l’eau. (Voir la Section 8.1.0 ci-dessus pour les 
concentrations appropriées.) Ne trempez pas ou n’inondez pas les surfaces et n’utilisez pas 
d’abrasifs qui pourraient rayer les surfaces. Ne laissez pas l’humidité entrer en contact avec 
les composants électriques du système. Testez les produits de nettoyage sur une petite zone 
non visible des capots en plastique et en métal pour vérifier qu’ils n’endommagent pas le 
revêtement. 
 

  
8.2.0 
Externe 

 
À l’exception des fusibles et des câbles externes, le système ne comporte pas de composants 
remplaçables par l’utilisateur. Les éléments suivants peuvent être commandés et remplacés 
par le personnel de Hologic ou des représentants agréés.  
 

• Détecteur de rayons X numérique. 

• Carte d’interface PCIe. 

• Ordinateur, écran, souris et clavier. 

• Carte contrôleur. 

• Tube à rayons X et alimentation HT. 

• Alimentation basse tension. 

  
8.3.0 
Pièces 
remplaçables 

 
• Cible de diffusion en acrylique (0,25" ~ 6 mm et 1" ~ 24 mm d’épaisseur). 
• Fantôme ACR (Nuclear Associates Réf. 18-250). 
• Radiamètre pour chambre d’ionisation, Inovision Modèle 451B-DE-SI-RYR ou similaire. 
• Bidon d’eau en plastique de 1 gallon (4 litres). 
 

  
8.4.0 
Matériel 
nécessaire 

 
Les références suivantes fournissent des informations qui amplifient ou augmentent les 
procédures de sécurité du logiciel, qui sont définies dans ce document. 
 
Sécurité et cybersécurité 
Toute mise à jour de logiciel ou de micrologiciel effectuée depuis la maintenance précédente 
et qui résout un problème de sécurité ou de sûreté peut être fournie si nécessaire.  
 
Le micrologiciel est codé en dur dans la carte de commande, donc si une mise à jour du 
micrologiciel est nécessaire, remplacez la carte de commande du panneau de commande.  

  
8.5.0 
Documents de 
référence et 
informations sur 
les versions 
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Les définitions suivantes s’appliquent aux termes énumérés ci-dessous lorsqu’ils sont 
mentionnés dans le présent calendrier de maintenance : 
 
ADU : analog-to-digital units (Unités analogiques-numériques).  
 
AEC : automatic Exposure Control (Contrôle automatique de l’exposition) — L’ordinateur met 
fin aux rayons X lorsque suffisamment de signal a atteint le détecteur. 
 
Agrandissement : éloignement de l’objet du détecteur et rapprochement de la source de 
rayons X pour agrandir l’image de l’objet sur le détecteur. 
 
Bruit de lecture : mesure du bruit RMS pendant une exposition sombre de 0 seconde (pas de 
signal). 
 
Champ plat : corrections de gain et de décalage effectuées pixel par pixel. Chaque pixel a un 
gain et un décalage différents et doit être étalonné. 
 
Contraste : pourcentage de différence entre l’intensité de l’objet et l’intensité de l’arrière-plan. 
 
Courant d’obscurité : signal généré thermiquement dans le capteur ; (presque) linéaire dans 
le temps. 
 
Fantôme ACR : fantôme d’accréditation de l’American College of Radiology. 
 
MTF : modulation transfer function (Fonction de transfert de modulation). Mesure du contraste 
et de la résolution d’un système d’imagerie. 
 
Paires de lignes par millimètre : nombre d’éléments de plomb et d’air alternés. Par exemple, 
10 lp/mm signifie => {air/plomb} {air/plomb} ... 10 fois par millimètre. 
 
Radiographie d’échantillons : imagerie radiographique d’un morceau de tissu 
après son extraction du corps. 
 
ROI : region of interest (Région d’intérêt). Généralement une sous-région spécifique d’une 
image. 
 
SID : source-to-image distance (Distance source-image) ; distance entre la source de rayons 
X et le détecteur. 
 

 8.6.0 
Définitions 

 
Une maintenance périodique doit être effectuée une fois par an pour garantir que votre système 
Faxitron Path continue à fonctionner de manière optimale dans le temps. Cette maintenance 
périodique comprend la vérification des éléments suivants : 

• Verrouillages et indicateurs de sécurité, Section 8.8.0. 

• Test avec fantôme ACR (vérification des performances de la caméra), Section 8.8.1, et 

• Contrôle du rayonnement, Section 8.8.2. 
 
Nous recommandons que ces procédures soient effectuées une fois par an, mais les 
réglementations gouvernementales peuvent exiger des calendriers d’entretien plus fréquents. 

  
8.7.0 
Maintenance 
régulière 
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Verrouillages, voyants, messages d’erreur – À effectuer une fois par an 
 
Imprimez cette page pour l’utiliser comme référence si nécessaire. 

Enregistrez les résultats sous « Verrouillages, voyants, messages d’erreur » sur le registre de 
maintenance périodique — Faxitron Path, situé à la fin de la Section. 

 

 8.8.0 
Verrouillages et 
indicateurs de 
sécurité 

1. Le système doit être sous tension. L’interrupteur à clé doit être en position « 3 heures » et 
la clé doit être impossible à retirer. 

 
2. Vérifiez que le voyant « Power » (Alimentation) s’allume. Aucun autre voyant n’est allumé 

à ce stade.  
 
3. Assurez-vous que l’écran LCD s’allume et affiche « System Idle » (Système inactif) et qu’il 

n’y a pas d’autre message, tels que « Door Open » (Porte ouverte) à ce moment-là.  
 
4. Ouvrez la porte du compartiment à échantillon. L’écran LCD affiche le message « Door 

Open » (Porte ouverte). Lorsque la porte est refermée, ce message doit disparaître. 
 
5. Allumez l’ordinateur et l’écran. Le logiciel Vision doit démarrer automatiquement. Si le 

logiciel ne démarre pas automatiquement, double-cliquez sur l’icône du logiciel Vision pour 
démarrer le logiciel d’imagerie. Si cela déclenche un étalonnage, laissez-le s’achever 
complètement.  

 
6. Ensuite, cliquez sur le bouton Start Procedure (Démarrer la procédure), puis sur le bouton 

Patient Data (Données du patient) et choisissez le bouton Enter Manually (Entrer 
manuellement) pour accéder à l’écran de saisie du patient. Remplissez tous les champs 
marqués d’un astérisque (*) et cliquez sur le bouton « Accept » (Accepter). Cela permettra 
de faire une exposition. 

 
7. Vérifiez que le voyant « Ready » (Prêt) est allumé. L’écran LCD affiche également un 

message « Ready » (Prêt). 
 
8. Appuyez sur la touche verte « X-ray » (Rayons X) située à l’avant du Faxitron Path. Le 

système devrait débuter une exposition aux rayons X. Assurez-vous que l’écran LCD affiche 
l’indicateur à barres pour l’exposition, ainsi que la valeur kV et la durée d’exposition. Vérifiez 
également que le voyant « X-Ray On » (Rayons X activés) s’allume. Un court bip est 
également émis environ une fois par seconde pendant l’exposition. Laissez l’exposition 
s’achever et assurez-vous que l’image s’affiche sur l’écran de l’ordinateur. 

 
9. Appuyez à nouveau sur le bouton vert pour démarrer une autre exposition. Pendant 

l’exposition, appuyez sur le bouton rouge « Stop » (Stop) : normalement, le rayonnement 
doit s’arrêter dans les 2 secondes suivant la pression sur le bouton. Le signal sonore 
cessera notamment de retentir pour indiquer que l’exposition a été arrêtée. Le logiciel 
affichera des erreurs d’interruption, ce qui est normal. Les erreurs peuvent être effacées, 
ce qui permet de reprendre la génération de rayons X. 

 
10. Appuyez à nouveau sur le bouton vert et laissez le rayonnement démarrer. Cette fois, ouvrez 

la porte du compartiment à échantillon ; ceci devrait déverrouiller les interrupteurs de sécurité 
et forcer l’arrêt du rayonnement. Le logiciel peut afficher des erreurs, acquittez-les. 
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Fantôme ACR (insert en cire uniquement) – À effectuer une fois par an 
 
Imprimez cette page pour l’utiliser comme référence si nécessaire. 

Enregistrez les résultats sous « Test avec fantôme ACR » sur le registre de maintenance 
périodique — Faxitron Path, situé à la fin de la Section. 

 
L’utilisateur doit être familiarisé avec l’utilisation du Faxitron Path et doit connaître les 
procédures de prise de radiographies. Achevez les procédures de configuration et assurez-
vous que la caméra est étalonnée (notez le kV et la durée d’étalonnage), saisissez les données 
du patient et prenez une image de la partie de l’insert en cire du mini fantôme ACR illustré à la 
Figure 8.1.  REMARQUE : l’insert en cire doit être retiré de son support en acrylique. 
 
 
 
 
 
Le mini fantôme ACR contient 12 objets : 
4 masses, 4 fibres et 4 groupes de 
calcifications (taches). Chaque groupe 
de calcification contient 6 calcifications 
ou taches individuelles. Toutes les 
masses, fibres et calcifications doivent 
être visibles. 
 
 
 
 
 
 

 Remarque : le dernier groupe de 
calcifications peut ne pas être visible sur 
cette image. 
 
 
 
 
CRITÈRES D’ACCEPTATION 
 
1. Configurez le système pour prendre une image manuelle de l’insert en cire du mini fantôme 

ACR. Réglez les kV et la durée sur ceux notés lors de l’étalonnage. 

2. Assurez-vous que le fantôme est propre et exempt de tout débris. 

3. Placez l’insert en cire directement sur le sol de la chambre au milieu de la zone d’imagerie. 
N’utilisez pas de bloc d’atténuation. 

4. Démarrez l’exposition aux rayons X, attendez que tous les traitements soient achevés et que 
l’image soit affichée. 

5. Tous les objets du fantôme peuvent ne pas être visibles lorsque l’image est affichée pour la 
première fois. Ajustez les niveaux de contraste et de luminosité selon vos besoins pour 
obtenir une meilleure image. 

6. Une fois l’image corrigée, tous les groupes d’objets doivent être visibles. 

7. Consignez les résultats dans le registre de maintenance périodique. 

 8.8.1 
Test du fantôme 
ACR 
 
 
 
 
 
 
 
Figure 8,1 
Image radiographique typique de 
l’insert en cire du mini fantôme 
ACR (Nuclear Associates Réf. 
18-250). 
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Contrôle du rayonnement – à effectuer au moins une fois par an ou si le 
dispositif a chuté ou a été endommagé. 
Les pages suivantes peuvent être imprimées et utilisées comme instructions aux fins du 
contrôle du rayonnement. 

Enregistrez les résultats sous « Contrôle du rayonnement » sur le registre de maintenance 
périodique — Faxitron Path, situé à la fin de la Section. 

Le fabricant recommande qu’un contrôle du rayonnement soit effectué au moins une fois par 
an* pour s’assurer que les émissions de rayonnement sont dans les limites admissibles. Si la 
machine est endommagée d’une quelque façon après son installation, alors le contrôle 
radiographique doit être effectué avant de remettre la machine en service dans l’établissement. 

 
Outils nécessaires 
• Appareil de contrôle du rayonnement avec source de contrôle (radiamètre pour chambre 

d’ionisation recommandé, comme l’Inovision 451B, la source de contrôle est fournie avec 
l’appareil). 

• Bidon d’eau en plastique de 1 gallon (4 litres). 

 
Vérification du fonctionnement du radiamètre 
1. Date d’étalonnage : vérifiez que l’étalonnage du radiamètre est à jour. 

2. Vérification de la batterie : vérifiez l’état de la batterie. Remplacez les batteries si 
nécessaire. 

3. Vérification du fonctionnement : (si la source de contrôle est disponible.)  
 Remarque : les étapes suivantes s’appliquent à Inovision 451B ou à des radiamètres 

pour chambres d’ionisation similaires. Suivez les instructions des fabricants pour les autres 
radiamètres. 

• Ouvrez le blindage coulissant contre les rayons bêta situé au bas du radiamètre. 

• Réglez le radiamètre sur la source de contrôle et surveillez pendant 30 secondes. 

• Le radiamètre doit donner des valeurs dans les limites de tolérance indiquées sur 
l’étiquette d’étalonnage. 

• Consignez les mesures dans le registre de maintenance périodique. 

• Refermez le blindage contre les rayons bêta du radiamètre. 

 
Remarques importantes 
1. Toutes les mesures de rayonnement sont effectuées avec le radiamètre à moins de 5 cm 

(2 po) de la surface du Faxitron Path. 

2. Lors de l’enregistrement des mesures de rayonnement, il peut être nécessaire de les 
multiplier par 0,1 pour convertir la lecture de uSv/h en mR/h. Par exemple, 12 uSv/h est égal 
à 1,2 mR/h. 

 8.8.2 
Contrôle du 
rayonnement 
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Procédure de contrôle du rayonnement 
 
1. Relevez une valeur du rayonnement de fond (pointez l’appareil de mesure vers le centre de 

la pièce) et enregistrez la valeur. 

2. Configurez le système pour prendre une image manuelle. 

a. Cliquez sur le bouton du panneau de commande du dispositif et sélectionnez Full 
Manual (Manuel complet).  

b. Faites glisser les curseurs kV et Time (Durée) tout à droite pour maximiser les valeurs 
kV et de durée sélectionnées. 

c. Cliquez sur le bouton « SET » (Définir). 

3. Vérifiez que le voyant « Ready » (Prêt) est allumé. 

4. Ouvrez la porte du compartiment à échantillon. Placez le bidon d’eau en plastique de 4 litres 
(1 gallon) au sol dans la zone d’imagerie de la chambre et fermez la porte. 

5. Appuyez sur la touche « START » (DÉMARRER) et relevez les émissions de rayonnement 
au sommet, à l’avant, à l’arrière et sur les deux côtés de l’armoire. Balayez lentement toutes 
les surfaces avec le radiamètre. Il faut normalement compter 1 à 2 expositions aux rayons X 
pour chaque balayage.  Remarque : vous devrez lancer plusieurs fois les émissions de 
rayons X pour effectuer le contrôle du rayonnement dans son intégralité. 

6. Consignez les valeurs pour chaque emplacement de test. 

7. Si l’une des valeurs est supérieure à la limite d’émission de rayonnement du Hologic 
à hauteur de 0,1 milli-Roentgen (mR) par heure (1,0 µSv/h) en un point quelconque situé à 
5 centimètres (cm) à l’extérieur de la surface externe (*), contactez un représentant de 
Hologic pour discuter des options de réparation. 

(*) 0,5 mR/h à 5 cm des surfaces externes est la limite supérieure fixée par le CDRH de 
la FDA américaine pour les équipements à rayons X montés en armoire. Si l’appareil 
est utilisé dans un autre pays, veuillez vérifier les limites officielles du pays pour les 
équipements à rayons X montés en armoire utilisés à des fins de diagnostic in vitro. 

Pour certains pays, les points de test doivent être à 10 cm des surfaces externes et 
dans ce cas, l’émission de rayonnement des systèmes doit être inférieure à 0,1 mR/h à 
10 cm des surfaces externes. 

8. Retirez le bidon d’eau de la chambre à rayons X.  

9. Le sol de l’armoire de radiographie doit être analysé si le système est posé sur une table ou 
s’il y a du personnel à l’étage inférieur. Vérifiez qu’il n’y a rien dans la chambre à rayons X, 
lancez une radiographie et balayez le fond de l’armoire. Enregistrez les mesures. 

 8.8.2 Suite 



 

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | RÉVISION 001   

SECTION 
Calendrier de 
maintenance 8 

8-8 

Faxitron® Path 
Système de radiographie d’échantillons 

Registre de maintenance périodique — Faxitron Path   
N° Série du système :  ______________________     N° Série de la caméra :  ______________  

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

La maintenance périodique susmentionnée a été effectuée par :  __________________________________  

Date de l’exécution :  ___________________  Signature :  ________________________________________  

Verrouillages et indicateurs de sécurité — Conformément à la section 8.8.0 

Réussite :  _________  Échec :  ________  Initiales :  _______  Date :  ________________  

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec. 

 _________________________________________________________________________________  

 _________________________________________________________________________________  

 _________________________________________________________________________________  

Initiales : ____________  Date : ______________  
 
 Test avec fantôme ACR — Conformément à la section 8.8.1 

Nombre d’objets observés : Masses : _______  Fibres : ______  Groupes de calcification : ______  

Réussite : ________  Échec : _______  Initiales : ________  Date : _________________  

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec. 

 _________________________________________________________________________________  

 _________________________________________________________________________________  

 _________________________________________________________________________________  

Initiales : ____________  Date : ______________  
 
 Contrôle du rayonnement — Conformément à la section 8.8.2 

Lectures du rayonnement en : mR/h µSv/h Source de contrôle : __________________  

Arrière-plan : ___________________  

Avant : ______  Côté droit : _____________  Dessus : ____________  

Retour : _____  Côté gauche : ___________  Dessous : ___________  

Réussite : _________ Échec : ________  Initiales : _______  Date : __________________  

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec. 

 __________________________________________________________________________________  

 __________________________________________________________________________________  

 __________________________________________________________________________________  

Initiales : ___________  Date : ______________  
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